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Abstract 

In VLSI design many IC'sare designed by using automatic tools that assist the user with ob
taining a layout of the final IC from a functional specification. While all intermediate steps 
(transforming the functional specification into a network) are carried out rather optima!, the 
final step (the generation of the floorplan frorn a network) is often not. lt is however this step 
that has a direct effect on the floorplan size and thus the price of the final IC. 

In order to obtain smaller floorplans the floorplans generated by a computer need to be op
timised. For this task the designer can use the interactive floorplan optimiser (IFO) as pre
sented in this report. lt is a tool that runs under X WINDOW and Iets the user tweak the floor
plan. Functions that can be perforrned are: Rotating, rnirroring and moving cells or groups of 
cells. In order to keep the floorplan feasible (the channels must be wide enough to incorpo
rate the nets) it must.be rerouted now and then by rneans of an external global routing tool 
(GLOBROUT). 

Experiments have shown that the IFO tool can indeed shrink the size of a floorplan but in 
what extend is not quite clear since not enough test floorplans were available. 
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Chapter 1 

Introduetion 

An important step in the design process of an Integrated Circuit (IC) is the design of the lay
out. Aftera networkis designed that fulfills the wanted functionality and all needed modules 
are determined, this step determines how the final IC would look. Of course the functional
ity must be maintained but it is important that the finallayout (and thus the IC) becomes as 
smallas possible. This ensures a list ptice that is as low as possible. 

The IC designprocessin a nutshell is sketched below. First a structural behaviour is generated 
from a functional behaviour. This determines what the IC should do and how it should be 
done. This step is called the High Level Synthesis. The output of this step is a network of 
modules and their interconnection. 

Next comes the Logic Synthesis step. This step determines how the modules from the HLS 
step are filled in. That is generating a logical network with AND, OR or INVERTER gates. 
This networkis often mapped on (realised by) standard cells from a library. 

The last step in the design process is the generation of the layout of the IC (the floorplan): 
The Layout Synthesis. This step takes the gates or cells from the previous steps and translates 
them into transistors. These transistors are more or less just reetangles of metal and silicon 
that are stacked on top of each other. The Layout Synthesis step determines the position and 
sizes of these rectangles. Also the interconnection (wires) are generated. 

The big problem of the Layout Synthesis step is where to lay down each cellso that the over
all size of the floorplan is as smallas possible. Since IC's can be very large this problem can 
hardly be solved by hand. Therefore Computer Aided Design tools are developed that tackle 
this task. Like all computer programmes these tools exploit a certain algorithm to accomplish 
their tasks. 

One of the algorithms used to place the cells on a floorplan is the min-cut algorithm (see for 
example [1] for the SLICE floorplan generator) totransfarm thesetof cells in a slicing struc
ture. The ''basic idea" of this algorithm is to divide the set of cells in two subsets that have 
the least crossing nets. This is because it is hoped that cells that have a lot of interconneet will 
be put close tagether on the floorplan to avoid a huge overhead on wires. Furthermore the 
sizes of the sets are more or less kept in balance. Inlayout terms this can beseen as putting 
on half of the cells at one side of the floorplan and the other half at the other side. Aftereach 
subdivision the subsets are divided again until all subsets contain only one cell. 

1 



2 CHAPTER 1. INTRODUCTION 

If alternating cuts of the module set are thought of as being done in alterna te directions (for 
example the first cut makes two side-by-side columns while the second makes two rows on 
top of each other and so forth) it is quite easy to imagine how to combine the sets of cells to 
a 2-dimensional plane. The only thing we have forgotten sofarare the wires. These are laid 
out in channels between the cells. The sizes of the channels are determined by the number of 
wires tha t pass through them and are found by a glo bal router routine. N ow the finalla yout of 
the IC is known: We know the size of each module or celland the size of the channels between 
them. By packing these items as close as possible in a plane we get the layout of the IC. 

As said earlier there are computer programmes that can do these tasks. There is however a 
problem with this: Since most slicing programmes use heuristics the results are nat always 
satisfying. For example the slicing tooi might have decided to put two closely interconnected 
cells that could better be put in the sameslice in two different slices. Or (if it is a sirnple one) 
it could have put a smalland a large cell into adjacent slices. This leads to wasted space since 
the en veloping slice is minimal as large as the maximum size of one of its subslices. 

To obtain a better layout some manual post processing of the layout might be necessary. For 
this task the Interactive Floorplan Optimiser (IFO) was developed at the Design Automation 
section of the Faculty of Electronk Engineering of the Eindhoven University of Technology. 
This is a programme that works under the X WINDOW environment (see chapter 4). This en
vironment makes it possible to show a graphical representation of the floorplan and interact 
with the user in a comfortable way. This all in order to easily make changes to the floorplan. 
The input and output of this programme are floorplan files in a format that was developed 
by the same group. 



Chapter 2 

Interactive Floorplan Optimisation 

2.1 Introduetion 

In the previous chapter the need fora floorplan optirniser was outlined. In this section we will 
see which functions or transformations it could perform to produce a more optima! floor
plan. Also an abstract representation for floorplans is discussed and it is shown how these 
transformations can be realised on this representation. Since this tooi is not self-contained 
but needs human input, a way for interacting with the optirnisation tooi is presented also. To 
make things clearer further on a nurnber of terms will be defined fust. 

2.2 Vocabulary 

This section defines a nurnber of terms that will be used throughout this report. 

Floorplan A map of an IC that consistsof rectangles. Each rectangle is a cell from the network 
that defines the functionality. 

Slicing structure A special type of floorplan that is made by repeatedly cutting the envelop
ing rectangle into two subrectangles (often referred to as a slice). 

Module A module is a functional unit in a floorplan. Examples are an adder or an AOI
building block. 

Cell A cellis buildingblockof a floorplan; it is not subdivided any further. 1t incorporates a 
logkal function. Associated with a cell are its dirnensions and the positions of its pins. 
A cell can be an instanee of a particular module. 

Channel Space between cells in which the wires are placed. 

Row A rectangle in the floorplan that is cut one or more tirnes vertically. Thus a row consists 
of one or more reetangles next to each other. 

Column Sirnilar to a row. lt is a rectangle in the floorplan that consists of one or more reet
angles that are stacked on each other. 

3 



4 CHAPTER 2. INTERACTNE FLOORPLAN OPTIMISATION 

A row and a column are examples of a slice. 

Net A (virtual) wire that connects terminals. All terminals that are conneeled toeach other 
are on the sa me net. There are two kinds of nets: global and local. Global nets leave and 
orenter a channel while localnets stay within one channel. 

Terminal A place on a cellat which it is conneeled toa net. 

Pin A place on a cellat which it is conneeled toa net. 

The difference between a terminaland a pin is that a terminal is a "logica!" or "func
tional" conneetion toa cell while a pin is the "physical" conneetion toa cell. This means 
that all terminals of a floorplan must be conneeted to ensure a correct operation of the 
IC. The real conneetion of terminals is done at the pins. Thus a terminal can have more 
than one pin of which only one has to be connected. However it is somelimes beneficia! 
to conneet more than one pin of a terminal because the corresponding net is now routed 
through the celland thus saves space at another place. So a terminal can be seen as an 
internal net of a cell. 

Figure 2.1 illustrates these terms. The sample floorplan consistsof a row (Row 1) that consists 
of 3 subslices: A column (Column 1), a channel (Channel 1) and a cell (Cell C). Column 1 
consists too of 3 subslices: A cell (Cell A), a channel (Channel2) and another cell (Cell B). The 
dots in this figure mark the pins. Between the pins and through the channels run the local 
nets. Through channel 1 and 2 runs a global net and in channel 1 another global net leaves 
the channel. In cell B a terminal is used as a shortcut 

c: 
E 
:::::J 

0 u 

Row 1 

Cell A 

u 
Q) 

u 

Local Net 

Figure 2.1: Sample floorplan illustrating the above terms. 
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2.3 Transformations on Hoorplans 

This section presents the various transforrnations that can be perforrned on a floorplan. All 
these transforrnations share in cornrnon that they only change the layout of the design and 
not the functionality. Furtherrnore the following sirnplification is made: All nets have their 
pins rnapped on the center of the cells. In other words: The positions of the pins arenottaken 
into account but will be assurned to be at the center of the cells. 

The following list gives the transforrnations that could be perforrned on a floorplan and that 
are irnplernented in the tool. They will be discussed in more detail in the following sections. 

Rotation Cells or complete slicescan be rotated in steps of 90° clockwise or counter clock
wise. 

Mirroring Cells or complete slices are rnirrored in a horizontal or vertical "rnirror". 

Moving Cells or complete slices can be rnoved to a different location in the floorplan. For 
exarnple to free up sorne room or to fill up a gap. 

2.3.1 Rotation 

If a cellor slice is rotated its occupied area's height and width are swapped (the aspect ratio 
is inverted). Sametirnes this reduces the height or width of the slice at a higher level. There 
are however sorne consequences of rotating items in a floorplan. One of these is the fact that 
since now the orientation and the position of the cells is different, the nets rnight run through 
different channels now. And thus the width of the affected channels rnight be different now. 
This effect will not be accounted for by now and shall be solved by letting a global router 
rerout the design now and then. Another consequence of rotating a cell or slice is that the 
design size even can get bigger due to worse fitting of the slices. 

Rotation is irnplernented in steps of 90° clockwise and counter clockwise. This transformation 
is reversible. This rneans that doing a clockwise rotation aftera counter clockwise rotation 
(or vice versa) gets back the original orientation. Furtherrnore 2 clockwise rotations have the 
sarne effect as 2 counter clockwise rotations and 4 rotations in the sarne direction have no 
effect. 

2.3.2 Mirroring 

In contrast with rotation, rnirroring doesnotchange the aspect ratio. It does ho wever change 
the absolute position in the floorplan of the associated pins and thus the widths of the affected 
channels. If this effect has a positive or negative influence on the total design size is hard to 
say and is only known for sure aftera global router has been run. The rnirroring transforma
tion was rneant to maneuver cells that have relatively rnuch interconneet closer tagether and 
hence rninirnising wire length and or freeing up other channels. 

Mirroring can be done in horizontal and vertical direction. When using horizontal rnirroring 
the left to right order is reversed while with vertical rnirroring the top down order is reversed. 
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This means tha t a second rnirroring operation in the samedirection on the sa me object cancels 
out the first. 

2.3.3 Moving 

Moving around cells or slices is the most powerful operation that can be performed by the 
floorplan optirniser. The motivation behind moving cells or slices is to fill up somegapin the 
floorplan or to makesome room for fitting in a rotated cellor slice. As withall other transfor
mations on floorplans, the widths of some channels may change due to the new positions of 
some pins and hence the nets that conneet them. It is however quite possible to fit the design 
tighter tagether and hence reducing the size of the die. 

2.4 Aides on applying transformations 

In order to assist the user in editing the floorplan the following aides are implemented: 

Showing nets Shows the nets connected to a particular cell. Various styles can be used. 

Preselecting items Select a cellor slice in the floorplan for subsequent transformations. 

Information displays Shows some information of the selected item or the result of the last 
transforma ti on. 

Undo/redo If the result of the last action was not satisfying or it was done by mistake it can 
be undone and even this can be undone by a redo. 

Updating the floorplan Rerout the floorplan to calculate the new channel widths. 

In the following sections these aides are discussed in more detail. Insection 2.7 the interactive 
aspects of them will be discussed. 

2.4.1 Showing nets 

The transformations described above have as a side effect the displacement of terminal pins 
and therefore the route of some nets. If it can seen befarehand how many nets are connected to 
a given celland w here they lead to or co me from, better decisions for optirnising the floorplan 
can be made. Therefore a feature is irnplemented for selecting one ore more cells of which the 
nets they are connected to are visualised. The following three visualisation styles are irnple
mented: 

• Star 

• Geometrie 

• Bonnding box 
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In the star style for every net that is connected to the selected cell a line is drawn frorn the 
selected cell to all other cells on the net. The lines are drawn frorn the centers of the cells since 
exact pin positions are nat used. This is a fast visualisation. 

In geometrie style for every net that is connected to the selected cell the geometrie center is 
calculated and a line is drawn frorn this center to the centers of all cells on the net. The ge
ometrie center is calculated by taking the average of the x- and y-coordinates of the centers 
of all cells on the net. The center is graphieally ernphasised by drawinga dot in it. This style 
gives a good view of the biggest concentration of cells that are connected to the selected cell. 

Finallyin bounding box stylethenets are visualised by drawing, for every net on the selected 
cell, a box that encapsulates the complete net. That is: A box is drawn that encapsulates the 
selected celland each other cell on the net. This style gives a good view of the position of the 
selected cell in relation to the other cells it is connected to. 

In all cases the selected cellis accentuated with a different colour than other cells.lt is possible 
to switch between visualisation styles at runtime but all nets of the design are shown in the 
sarne style. Note that neither of these styles gives an irnpression of through whieh channels 
a net runs and where it splits. 

Frorn these views of the nets we can derive sorne floorplan rnodification rules of thurnb: 

• If a cell is in the rniddle of a cluster of cells it connected to it is aften nat wise to move it. 
This situation indieates that a lot of wires will move toa if this cellis rnoved and hence a 
nurnber of channels will get bigger. Nat tomention the overall negative effects of langer 
wires. 

• Following frorn the first rule: If a cellis far away frorn the geometrie center it rnight be 
sensible to move it closer to that center. 

• If a cell is connected to only one other cell, the penalty for putting this cell in another 
slice as the cell it is connected to, is relatively srnall. If the channel between thern is rela
tively braad, there rnay be no penalty at all. This is quite reasonable: If a cellis connected 
to only one other cell and the net between the two cells crosses a channel, this is a la
cal net per definition. lt is easier to worm an extra net through a braad channel than 
through a narrow one. Sametirnes this doesn't create an extra track and than there is no 
penalty. 

2.4.2 Preselecting items 

The floorplan optirniser has a function for selecting items in the floorplan. That item can be 
either a cell or a slice. The selected item will be highlighted and an inforrnation box will dis
play sorne useful inforrnation about that item. If an transformation is perforrned now it will 
be perforrned on the selected item. Else it would have been perforrned on the item selected 
next. Benefit of selecting an item befare applying a transformation is that the user can make 
sure the right item is selected and that the selection can be "grown" to incorporate otherwise 
nonselectable items such slices without channels. Also anitem stays selected aftera transfor
mation is applied so multiple transforrnations can be perforrned after another on the sarne 
item. 
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2.4.3 Information boxes 

In order to give the user some information about the state of the optimisation process two 
information boxes can be displayed. One box shows information about the selected item or 
the item that was last transformed. The type of information shown is dependent on the type 
of the cell but generally the name, place and size is shown. The second box shows information 
a bout the total floorplan. The most important information shown is the size of the floorplan 
and the covered area. 

2.4.4 Undoing and redoing actions 

If the last transformation that was performed hadn't got the desired effect or was done by 
mistake it can be undone. All transformations can be undone up to the first action applied 
to the floorplan. Undone actions can even be redone up to the last action performed! How
ever if a new transformation is performed this action becomes the last action. This "infinitely'' 
long history makes it easy to try some steps and turn them back if they don't lead toa better 
floorplan. 

2.4.5 Updating the floorplan 

Some of the transformations may change the routing of the nets and thus the widths of af
fected channels. By running a global router the new channel widths can be calculated. The 
global router that is used is GLOBROUT. GLOBROUT is a programme that is developed by L. 
v.d. Heuvel at the same section as where IFO is developed. See [3] for more info about the 
GLOBROUT programme. 

2.5 Representation of floorplans 

In the previous sections it was outlined what kind of transformations could be performed 
on floorplans. It was not outlined how these transformations could be performed with the 
use of a computer. Noteven an abstract (computer) representation of a floorplan was made. 
This section deals with that. The next section showshow to perform the transformations men
tioned earlier on this representation. 

2.5.1 Abstract representation of floorplans 

In the vocabulary section of this chapter a number of terms were discussed. In this section an 
abstract representation of some of them will be discussed. The global concepts of an abstract 
representation of a floorplan are the slicing tree and the net-, cell-and module lists. 
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2.5.2 The slicing tree 

Definition 2.1 Slicing tree 
A slicing tree is a tree in which the internalnodes represent the slices of a floorplan. The leafs 
represent the cells of the floorplan. 

0 

In its most restricted forma slicing tree is a binary tree in which all nodes at the same depth 
represent a slice in the samedirection (horizon tal or vertical). A more general slicing tree can 
have slices in the samedirection at successive levels. Also a leaf node can be of the channel 
type; in the more restricted variants the channels are implicitly at the slices and hence the 
channel information is already stared in the slice nodes. The piece of floorplan of figure 2.1 
can thus be translated into the tree of figure 2.2. 

Channel1 Cell C 

Cell A Channel 2 Cell B 

Figure 2.2: Slicing tree of sample floorplan of figure 2.1 

In this tree 4 types of nodes can be distinguished: 

1. Row nodes: Thesenodes are used to represent horizontal slices. A row node has 1 or 
more child nodes of either type. 

2. Column nodes: These nodes are used to represent vertical slices. Like a row node a col
umn node has 1 or more child nodes of either type. 

3. Module nodes: This node type is always a leaf node and represents a single cell in the 
floorplan. 

4. Channel nodes: This node type is also always a leaf node and represents the space in a 
floorplan that will be filled with the interconnection between the cells. 

A valid slicing tree thus consists of thesenodes with the restrietion that row and column 
nodes have at least one child and that noother node has any children. This means that it is il
legal fora row or column node to have no children. Also "void" nodes (nodes that are neither 
there in the slicing tree nor in the floorplan) are forbidden. As will become clear in the next 
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sectien it is sametimes desired that nodes of this type can be used. Therefore an new node 
type is introduced: The stub node. 

Definition 2.2 Stub node 
A stub node is a node that has no item in the floerplan associated withit but isused to keep 
the slicing tree valid (complete) and still have empty items. 

0 

Stub nodes usually don't have children1 . Their intended use is for marking locations in the 
slicing tree. Stub nodes are created by the floerplan optirniser and not used for input or out
put. 

All types of nodes have additional information associated with them. So do all nodes have a 
name which corresponds with the identifier of the item in the floorplan. Also all nodes, ex
cept stub nodes, have position, size and orientation information. The position information is 
a pair of (x,y) coordinates in the floerplan and the size information is the width and height of 
the item in the sameunits as the position coordinates. All measurements are in integral units 
and positions are relative to the lower left corner of the floerplan or item (which is the origin 
(0,0)). The orientation information consistsof an indicator that corresponds with the current 
orientation of the item in the floerplan relative to the default orientation (origin bottorn left). 
Some transformations change the orientation of the conesponding floerplan item and this 
change is reflected in the orientation information for each node. 

As said, row and column nodes are the only nodes that have children. The order of these chil
dren is important. For row nodes the children are given in left to right order in the floerplan 
(increasing x-coordinate of the children). For column nodes the children are given from bot
torn to top (increasing y-coordinate of the children). 

2.5.3 Data lists 

Apart from the slicing tree, also a data structure for maintaining information a bout the cells 
and the nets is needed. For this a list of all cells and a list of all nets is maintained: The cell 
list and net list. 

Further, for each cell a list of terminals is maintained that records which pins are used (the 
terminal list). Also for each net in the netlist a list of pins it is connected to is maintained. On 
top of these lists there is a module list. This is a list of all module types that are used in the 
floorplan. A cell is of a certain module type and thus general information a bout a cell can be 
stared once in a central list. The diagram in figure 2.3 should make clear how everything is 
stored. 

With these structures it is for example possible to find all nets of a given cell. First, take the 
first terminal of the cell. This terminalmayor may not be connected toa net.lf it is connected 
to a net, get the first pin of the net. By following the pin list of the net all pins or cells this net 
is connected to are found. If the last pin is found this net is done. Now go back to the cell's 
terminallist to get the next terminaland follow the net associated withit until all terminals 
are done. This procedure is foliowed by the net visualising aides. 

1 However, the implementation of slicing nodesas given in the next chapter leaves this option open. The u se 
for this could be to (temporarily) mark out part of a slicing tree. 
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Module List 

lil_---- I I_----
1~----•1 I I ... ----, 

p=========~=====~=;-----~-----~-~ I I 
I 11 I I I I 

Net List ----.!~~:....1---+t.~T~e~r~m~i n~a~l.r::~: -+L;..::::.~~~r.~--+t~~~~ 
_____ .. 

I 

~-~----.I 

Terminal : Terminal 

,----- .. , _____ .. 

Figure 2.3: Diagram showing the netlist, celllist and module listand how they are interrelated 

2.6 Mapping of transformations on the floorplan representation 

Now that we have defined an abstract representation of floorplans we can give a mapping of 
the transformations from section 2.3 on this representation. Sincesome of the transformations 
need a global floorplan repositioning function, this will be discussed fust. 

2.6.1 Global floorplan replacement 

The transformations that will be discussed in the following subsections are likely the change 
the layout of the floorplan; that's what the floorplan optirnisation is all about! Therefore there 
must be a way to reflect the result of a transformation on a single item of the floorplan to the 
whole floorplan. This is done by re-placement of the floorplan. The term "replacement" does 
in this context not refer to exchanging the floorplan with another one but means assigning 
new positions (places) to the items in the floorplan. 

Floorplan reptacement can be done by traversing the slicing tree in Depth First Search (DFS) 
order. This means that the child nodes are evaluated before the node itself. For the purpose of 
floorplan reptacement the child nodes are evaluated from left to right but this does not apply 
to the general DFS traversal. Thus starting from the root, the slicing tree is traverseduntil the 
fust leaf node is found. This node is the item (in most cases a cell but can also be a channel) 
that will become the lower left item in the floorplan and hence becomes (0,0) as position. N ow 
the next leaf is visited. If it is in the same row (i.e. it is a sibling of the node) it will have the 
same y-coordinate as the previous item but the x-coordinate will be equal to the x-coordinate 
of the previous item (0 in this case) plus the width of the item. Likewise for next-visited leafs 
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Figure 2.4: Floorplan illustrating the error in the simple size calculation of rows and columns. 
Rows and columns are indicated by putting the name in the channel. 

that are in the same column (and that arealso siblings in the slicing tree) the x-coordinate is 
the samebut the y-coordinate is equal to the y-coordinate of the previous item plus the height 
of that item. The position of a row or a column is the same as the position of its fust child. By 
continuing this algorithm until the root of the slicing tree is processed the whole floorplan is 
replaced. 

Note that the width of a row can be calculated by taking the surn of the x-coordinate of the 
last (right most) item and its width. The height of a row can be found by taking the maximum 
height of all its subslices. Sirnilar for columns: For the height take the surn of the y-coordinate 
of the last (top most) item and its height. For the width take the maximurn width of all its sub
slices. This sirnple strategy can makesome errors. Take for example the floorplan of figure 2.4. 
The dirnensions of column 3 are different than the enclosing dirnensions of the filled space in 
that column. For column 2 it is clear that the width is allright but the height isn't: The chan
nel in row 4 is not high enough. This leads to another fix that must be done: Channels must 
have the height of the row they are part of or the width of the column they are part of. Fig
ure 2.5 shows the right sizes of the channels and the rows and columns after the fixes have 
been applied. 

The size of the floorplan is the size associated with the root of the slicing tree and thus can 
easily be found be taking the width and height of this node. 

From this algorithm it becomes quite clear why the children of rows and columns are given in 
left-to-right and bottom-to-top order respectively: If the order wasn't specified there would 
be an order irnposed when replacing. N ow if some transformation would change the order of 
the children without the intention to change the order of the items in the floorplan, replacing 
the floorplan would have disastrous results! 
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Figure 2.5: The right dimensions of the rows and columns of the floerplan of figure 2.4. 

This kind of floerplan placement has a slight disadvantage. Since all items are packed to
gether as close as possible, items tend to be pulled towards the lower left corner of the floer
plan. It can however make a difference in channel width if the cells would be moved some
what to the right or to the top. This is the case since different pin positions can give rise to a 
different nurnber of tracks. The effect of this is relative small and this problem is left to the 
final floerplan assembler to solve. 

2.6.2 Rotation 

If anitem in a floerplan is rotated2 it looks like its height and width are swapped and that 
is exactly how the rotatien transformation of the floerplan optirniser works. Also the crien
tatien of the item changes. This change reflects the rotatien direction: Clockwise or counter 
clockwise. For the visuallayout the rotatien direction doesn't matter. For the floerplan it 
makes a lot greater difference because the terminals of a module are affected too by the ro
tation! Although the position (that is: The lower left corner) of the item isn't changed, the 
position of surrounding items is very likely to be affected. All the above mentioned changes 
can be made by changing the values associated with the item. In order to make the floerplan 
fit nicely tagether again after each rotatien the global replace function is performed. 

So far the rotatien of cells. Wh en rotating rows or columns a nurnber of (small) problems arise: 

• When rotating a row or column every other item in the same row or column must be 
rotated also (in the same direction). This can be done by doing a subtree traversalof the 
slicing tree starting with the row or column node. 

2 Recall that rotation can only be done 90° clockwise or counter clockwise. 
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• If a row is rotated it bec01nes a column and vice versa. Purthermare if a row is rotated 
clockwise its left most item becornes the top of the resulting row. This rneans that the or
der of the children of the row node must be reversed in order to makesure that the fust 
child of the resulting column node is the bottorn most item in the floorplan. Likewise, if 
a column node is rotated counter clockwise its bottorn most item (fust child node) be
cornes the right most item (last child node) in the floorplan. So the order of the children 
must be reversed to make the fust child the left most item again. 

• Opposite to rotating cells, rotating rows or columns does change the position of its sub
slices. There is however no need to worry about the new positions since they will be 
determined by the global floorplan replace function. 

When rotating a channel all cells in the sarne row or column are rotated also. This is done since 
plainly rotating a channel doesn't make sense since the shape and orientation of channels are 
deterrnined by the surrounding cells. 

Undoing a rotation is easy: Just rotate the sarne item in the opposite direction! 

2.6.3 Mirroring 

Mirroring (either horizontally or vertically) of cells in a floorplan has no visual effect: lts di
rnensions don't change. However the position of the terminals is changed so that the sur
rounding interconneet is changed. Initially the position Oower-left corner) is nat changed. 
Global floorplan replacernent is nat necessary but the global router foliowed by a floorplan 
placement rnay assign a new position. Mirroring also changes the orientation of the cell. 

Mirroring a row or column slice however does have an effect on the visuallayout. If a slice 
is rnirrored horizontally the order of the subslices (nodes) in the rows is reversed. Likewise, 
rnirroring vertically reverses the order of the nodes in the columns. If a subslice is rnirrored 
all cells in that slice are rnirrored toa and in the sarne direction as that slice. This can be done 
by doing a DFS traversal of the subslice tree and rnirroring all module nodes. Mirroring a 
channel results in rnirroring the row or column that the channel is part of. 

Since the order of subslices is changed the corresponding items in the floorplan get a new 
position that can be calculated using the global floorplan replacernent routine. In order to see 
the impact of rnirroring subslices a global routing must be done.lt rnight be well possible that 
nets that ran through the channels of the subslice befare rnirroring now have another route. 
Also the position of the terminals of the outgoing nets of the subslice are changed. lnternal 
nets in the subslice are affected less since they can be rnirrored in the sarne direction. Ho wever 
since the global nets rnight be changed the route of the local nets can also be different. The 
effect on the floorplan can only be determined if the global router has done its job. 

lt looks like that the floorplan replacernent is only needed for the subslice that is rnirrored 
since the positions of surrounding items are nat changed explicitly and the sizes of the items 
don't change either. However the global router rnay findother channel widths and thus other 
floorplan positions. 

The rnirroring transformation can easily be undone by redoing the rnirroring transformation 
on the sarne item and in the sarne direction. 
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2.6.4 Moving 

Moving floorplan items around is the hardest transformation to implement but also the most 
powerful. This transformation can change the layout rigorously. Since the position in the 
floorplan is changed explicitly it is necessary to do a global floorplan replacement. Also since 
the position of the terminals of the cells being moved change it is necessary to do a global 
rerout. 

In termsof the abstract representation, the slicing tree, moving floorplan items results in rnav
ing the corresponding node toanother parent. Four nodes are specially important for moving 
floorplan items: 

1. The souree node. This is the node being moved. Of course it corresponds with the floor
plan item that is to be moved. If the souree node is of type channel, the souree node is 
changed to the parent of the current souree node and thus to the encapsulating row or 
column. It wouldn' t have made sense to move around channels in a floorplan since they 
are determined by the global routerand the cells. 

2. The target node. This is the node corresponding to the floorplan item the floorplan item 
being moved is inserted next to. This can be a channel or a cell. The next section makes 
more clear how this "insert next to" works. 

3. The souree node's parent. Since it looses one of its children. 

4. The target node's parent. Since it gets a new child. 

A number of problems arise when moving around nodes like mentioned above: 

• The place of the souree node among the other children of the target node' sparent deter
mines the resulting place in the floorplan soit is mandatory that the child is inserted at 
the correct place. This is not so difficult to solve since it can be determined whether the 
souree must be inserted before or after the target node: If a floorplan item is to be placed 
right or above another floorplan item, its node must be inserted after the target node. 
If the floorplan item is to be placed before or below the target item it must be inserted 
before the target node. 

• Notall nodescan become the target of a move operation. Although there generally is no 
objection against the target node being in the same row or column as the souree node, 
two conditions must be met: 

1. The target node is not the same node as the souree node. 

2. If the souree node is a row or a column and thus represents a subslice of the floor
plan, the target node may not be part of that subslice. 

• When undoing a move operation the node must be placed back at the original loca
tion. So there must be a way tomark or otherwise memorise that originallocation. This 
was solved by inserting a stub node at that place. Undoing and redoing actions now 
involves just swapping the stub node and the node that represents the subslice. 
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• The new place of the souree node relative to the target node can be deterrnined if it is 
inserted before or after the target node. This may sound easy but what if the cell must 
be inserted at the left (before) or the right (after) of a cell node that is part of a column 
or if a cell must be inserted below or above a cell that is part of a row? This problem can 
be solved by adding a row node in the fust case or a column node in the second case. 
This extra node replaces the original cell node that is placed tagether with the souree 
node in the right order as children of the new node. 

• Inserting nodes may lead to the needof extra channel nodes. The problem of introduc
ing proper channel nodesis left to the global router. 

Undoing or redoing a move operation is just swapping two nodes: The old souree node and 
the stub node that was inserted at the original place of the souree node. How the programme 
keeps track of this information is outlined in the next section. 

2.7 The interactive aspect 

In this section the interactive aspects of the floorplan optimiser will be discussed. This in
cludes the way in which information is presented, how the floorplan is displayed and how 
the user can invoke the transformations from section 2.3 by using the mouse or keyboard. 

2.7.1 Graphical presentation 

Before outlining how transformations can be performed interactively on the floorplan the 
way the floorplan andrelevant information is displayed is discussed. But fust the layout of 
the application itself is discussed. 

The application layout 

The lnteractive Floorplan Optimiser is written for the X WINDOW environment using OSF
Motif. Using this interface it is easy to make a programme that works in a graphical environ
ment. Like a typical GUl application it has a programme window with a menu bar at the top 
and a canvas window beneath it. The application window can be resized, moved or hidden 
(minirnized), raised or lowered. How this works depends on the window managerand will 
not be discussed here. 

The menu bar 

In the menu bar the user can select the following pull-down menus: 

File This pulldown menu gives the user the following options: 

Load Load a design from disk. 
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Save Save the current design to disk. 

Quit Leave the programme. 
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Edit This pulldown menu provides the user with a list of actions to rnanipulate the floorplan 
and cover the transforrnations frorn section 2.3 and sorne extras. The next subsection 
gives more details on how to apply these transforrnations. 

View This pulldown menu gives the user the following options (the next subsection tells 
how to do the necessary selections): 

Show nets Shows the nets that are connected to a certain cell. 

Show all nets Shows all nets in the floorplan. 

Net drawing style Presents a dialog box that Iets the user choose one of the styles for 
showing nets. The dialog box has 3 radio buttons, each representing a style. The 
OK/ Close button rernoves the dialog box. As long as the dialog box is visible the 
user can select a net drawing style that is activated irnrnediately by redrawing all 
visible nets in the new style. 

Show text Toggle whether module narnes are displayed or nat. By default module 
narnes are displayed but when very large designs are displayed the screen gets 
clouded with unreadable narnes. Purthermare nat drawing the module narnes 
speeds up drawing of the floorplan. 

Zoom in Zoom in on the floorplan. The user must draw a rectangle on the floorplan 
that will be zoorned in on. 

Zoom reset Scales the floorplan in such a way that it is totally visible. 

Zoom out Zoom out on the floorplan. Like the zoom in option a rectangle must be se
lected. The new visible part will be that part that must have been visible if the cm
rent visual part was obtained by zoorning in frorn it to the selected area. 

Show design info Opens an inforrnation box that displays sorne inforrnation a bout the 
current design. The close button of this box rernoves the box. The info is updated 
autornatically if the floorplan is changed. The box is also rernoved if the menu item 
is chosen again. The info box is opened at start up time. 

Show node info Opens an inforrnation box that displays sorne inforrnation about the 
currently selected node. The inforrnation that is shown depends on the type of 
node that is selected. This box is opened autornatically as the fust node is selected. 
It can be closed by the close button or reselecting this option frorn the menu. 

Besides these pulldown rnenus the menu bar has these features: 

Mouse position box The position of the rnouse is displayed in floorplan coordinates. If the 
rnouse moves these coordinates are updated. If the rnouse moves outside the floorplan 
area no coordinates are displayed. 

Undo Shortcut for undoing the last transforrnation. The effect is the sarne as selecting the 
undo option frorn the edit pulldown menu or the popup menu. 
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Redo Shortcut for redoing the last undo action. The effect is the same as selecting the redo 
option from either edit menu. 

Having the undo and redo options right available enables the user to quickly switch 
back and forth between two versions of the floorplan and judge the results of a trans
formation. 

The canvas window 

The largest part of the applications window consists of the canvas window. In this window 
the floorplan will be shown and user actionscan be performed here (see next section). Also 
apopup window can be used for selecting an transformation to be performed. 

The canvas window has two controls: A horizontal and vertical scrollbar. These serallbars 
can be used to move around in a floorplan that doesn't fit in the window at the current scale. 
The serallbars workas follows: Pressingandreleasing the left mouse button while the cursor 
is on the arraws at either side of the serallbar reveals more of the floorplan in that direction. 
The amount of floorplan shown is visualised by the size of the slider relative to the size of 
the total scrollbar. So the size of the slider is dependent on how deep the user is zoomed in 
on the floorplan. The visual part of the floorplan can also be set by rnaving the slider directly. 
This is done by clicking the slider with the left mouse button and rnaving the mouse while 
holding the button pressed. If the mouse button is released the motion is stopped. 

The floorplan is drawn in a sirnple manner: The cells or modules are drawn as a yellow rect
angle while the channels are drawn using a grey rectangle. Unused space remains white (the 
color of the canvas). A module that is selected will be drawn in red but a subslice that is se
lected will have all colours inverted. How this looks like depends on the X-server and the 
other applications currently running on the desktop. 

The colour of the nets depends on the net drawing style. The IFO application uses two col
ours: colourl (blue) and colour2 (light green). In star mode all wires will be drawn in colourl. 
In geometrie mode the net centers and the segments from the selected cell to the net center 
are drawn in colour2 and the other segmentsin colourl. In bounding box mode all boxes are 
drawn in colour2. 

All colours mentioned above are the default colours and can be changed by setting other val
ues in the . Xdefaul t s file or on the cammand line (see section 5.2.2). 

It is also possible to select an operation to be performed next by pressing the right mouse 
button somewhere in the canvas window. Apopup window will appear that is sirnilar to the 
edit pulldown menu. By selecting one of the options the operation mode will be set. The close 
option removes the popup window without selecting an operation. 

2.7.2 Applying transformations 

How to do selections 

All transformations and some of the options from the view menu option require some iloar
plan item to be selected. This section tells how to do that. 
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A single floorplan item can be selected by positioning the cursor, that willlook like a pointing 
hand, in the canvas window over the desired item and pressing the left mouse button. The 
hotspot (the point that really is selected) is just before the pointing finger. If the mouse pointer 
was over a cell, the cell will be selected. If it was over a channel the row or column it is part of 
will be selected. The node info box will be updated immediately. Depending on the operation 
to be performed on the node (see next section) it will be carried out immediately too. 

Anitem can be unselected in two ways. One way is by selecting another item since only one 
item can be selected at one time. In this case the other item becomes the currently selected 
item. The other way is by re-selecting the currently selected item. In this casethereis no longer 
an item selected. 

lt is possible to grow or shrink a selection. This can only be clone in selection mode. Grow
ing a selection means that instead the currently selected item the next higher row or column 
is selected. Shrinking a selection is more or less undoing a selection growth. The procedure 
for growing and shrinking is as follows: First selectanitem as described earlier. Now press 
the ">" key forenlarging the selection or the '' <" key for shrinking the selection. Shrinking 
a selection can only be clone when the current selection is the result of a previously grown 
selection3 . A selection can always be grown. Of course a selection can't be grown larger than 
the complete floorplan. lt is very well possible to undo a growth by a shrink. In that case the 
previous selection will become the current selection. This un-growing can be repeated until 
the first selection. 

The zooming operations require another type of selection to be made: Selectinga rectangle. 
This is clone by positioning the cursor in the canvas window at one of the corners of the rect
angle. The cursor willlook like a square with two arrows coming out of it. The hotspot is at 
the center. N ow press the left mouse button and move the cursor w hile keeping the left mouse 
button pressed. A rectangle will be drawn to show the selected area. The position where the 
mouse button is released marks the other corner of the rectangle. After the rectangle is se
lected the zoom is carried out. 

2.7.3 Undoing and redoing 

All transformations on the floorplan can be undone or redone. This can be done in several 
ways: 

• By selecting the Undo or Redo option from the edit menu. 

• By selecting the Undo or Redo option from theedit pop up menu. 

• By pushing the Undo or Redo button on the menu bar. 

• By pressing the "U" or uR" key on the keyboard. 

In all cases the undo or redo action will be carried out immediately and the resulting floorplan 
will be shown. In case there is nothing to be undone or redone an error message is printed in 
the TTY-terminal. 

3 This includes the constraint that singlecellor channel selections can't be shrunk since these selections can't 
betheresult of a growth of a nother selection. 
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2.7.4 Applying transformations from theedit menu 

The edit menu (either the one frorn the menu bar or the popup one) has the following options: 

Select Enables "selection mode". In this mode it is possible to make selectionsas described 
above. Also the ">" and "<" key have effect. 

If an item is selected fust and then a transformation is chosen frorn theedit menu, that 
transformation will be carried out irnrnediately. Every timeanitem is selected the node 
info box shows sorne inforrnation a bout the selected item and the selected item is high
lighted in the floorplan. 

Move Move a floorplan item to another place. How this option works depends on if there is 
already sarnething selected or nat. 

• Th ere is no item selected. N ow the item to be rnoved mustbeselect ed. This is done 
as described above with the exception that the left rnouse button rnay nat be re
leased yet. Now that sarnething is selected we can move this itemtoa different 
place. This is done by rnaving the rnouse while keeping the left rnouse button 
pressed. As the item is rnoved it will be visualised by a crossed wire frame and 
the optionally the name of the item. The item sticks at the center to the rnouse cur
sor. If the left rnouse button is released the floorplan item is fixed at the nearest 
place in the slicing structure. 

• There is already sarnething selected. In this case the floorplan item will be visu
alised in the sarne way as the previous case. If the rnouse is rnoved the selected 
item follows the pointer. The item can be reinserted in the floorplan at the desired 
place by pressing the left rnouse button. 

In bath cases the floorplan will be updated irnrnediately. During the move operations 
the rnouse cursor willlook like the one in figure 2.6. The hotspot is in the center of the 
cursor. 

Figure 2.6: Cursor shape for rnaving operations. 

There is still sarnething to say about the place where anitem is released and where it 
will be inserted in the floorplan. This depends on the relative position of the item being 
rnoved (the souree node, see section 2.6) and the item next to which the rnaving item is 
to be released (target node). 

The following figure 2.7 should make things clear. The target item can be divided in 4 
"quadrants". The quadrant in which the center of the souree item falls is the quadrant 
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next to which the souree item will be inserted. The item will be aligned with the left 
sides of other items in a column or with the bottoms of the other items in a row. 

' / ' / ' / ' / 1<----------.t 

Figure 2.7: Diagram showing the relation between the relative position of the souree item to 
the target item and where it will be inserted. 

Rotate CW & Rotate CCW Rotates the selected floorplan item clockwise respectively coun
ter clockwise. If nothing is selectedat the moment the programme goes into selection 
mode. In this case the cursor will change to the shapes of figure 2.8. The hotspot is at 
the point of the arrow. 

Figure 2.8: Cursor shapes for rota te clockwise and rotate counter clockwise operations. 

Mirror Horizontally & Mirror Vertically Mirror the selected floorplan object in the horizon
tal respectively vertical plane. If nothing is currently selected the programme goes into 
selection mode. In this case the cursor will change to the shapes of figure 2.9. The hot
spot is at the center of the cursor. 

Update Floerplan Calls the external global router to make a new floorplan with the new 
channel widths. 

Undo & Redo Undo the last operatienor redo the last undone eperation as described above. 

Close Only in po pup edit menu. Removes the po pup edit menu. Nothing changes. 
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Figure 2.9: Cursor shapes for mirror horizontal and mirror vertical operations. 

Section 5.4 gives some tips on editing the floorplan. 

2.7.5 Using the keyboard 

Although the X WINDOW environment provides a perfect way for making applications that 
use the mouse as input device it is sametimes handy to use the keyboard as well. Therefore 
when the keys from table 2.1 can be pressed while the cursor is in the canvas. 

Table 2.1 Keys that can be used in the IFO application 
Key Function 
<,I Shrinks the current selection 
>,. Grows the current selection 
e, E Same as selecting Exit from the File menu 
f, F Same as selecting Redraw Screen from the View menu 
h,H Same as selecting Mirror Horizontally from the Edit menu 
i, I Same as selecting Show slicing stats from the View menu 

m,M Same as selecting Move from the Edit menu 
n Same as selecting Show /hide selected net from the View menu 
N Same as selecting Show /hide all nets from the View menu 
r Redo last undo 
R Same as selecting Zoom reset from the View menu 
s Same as selecting Select from the Edit menu 
s Same as selecting Net drawing style from the View menu 

t, T Same as selecting Visible text from the View menu 
u, U Undo last transformation 
v, V Same as selecting Mirror Vertically from the Edit menu 

z Same as selecting Zoom in from the View menu 
z Same as selecting Zoom out from the View menu 

Numeric4 Same as selecting Rota te CCW from the Edit menu 
Numeric 6 Same as selecting Rota te CW from the Edit menu 

In the table above the fust key is the preferred key while the second key is an alternative that 
may be assigned a new function in new versionsof the programme. If a key is pressed that 
is not assigned to a function an appropriate error message is printed. 
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2.8 Input and output 

All information of the floorplans is read in from files. The slicing tree is read in from a .slice 
file or a .flp file. The list information is derived from a .nl file. These files are discussed in 
appendix A. 

When a design is loaded there may be two possible input files that can be used: A .slice file 
or a .flp file. A .slice file is similar toa .flp file except that a .slice file doesn't contain channel 
or net information. Which one is used depends on the time stamp of the files: Always the 
youngest file is used. 

If a design is written toa file always a .slice file is written. This must be done since IFO doesn't 
ensure correctnessof the channel and nets information. GLOBROUT writes out .flp files (since 
it routes the nets it certainly knows about the channels!). IFO in this case always reads this 
.flp file. Note that GLOBROUT produces a .flp file from a .slice so the time stamp of the .flp file 
is later than that of the .slice file. This means that if IFO is quit aftera final update operation, 
the next time IFO loads the design the .flp file is laad ed. If the user madesome changes after 
this update and saved the result befare quitting, the next time the design is loaded the .slice 
file is used. 

Besides the explicit 1/0 the following is done: 

• The design to be loaded is searched for in a speellied path. Once the design is found 
(see sec ti on 5.2.1), this directory becomes the working directory. 

• If a design is loaded, backups are created of the original files. These backups are stared 
in the working directory under the narnes backup. slice and backup. flp. Existing 
backups are overwritten and a warning is given if either of the input files does nat exist. 

• Every time a new design is loaded a log file is created with the samename and extension 
".log"4 • Every transformation is logged in this file. Even undo or redo actions are logged 
as is the updating of the floorplan and the result of this action. 

4 If such alogalready exists it is overwritten. 
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Chapter 3 

Abstract Data Types 

3.1 Introduetion 

This chapter describes the various datatypes and structures that were used in the IFO pro
gramme. This includes the implementation in the C prograrnrning language. Also references 
are made to the previous chapter where the transformations are outlined and how they can 
he mapped on the abstract datastructures. First the datastructures that are used to store the 
floorplan information are discussed. Next come sometables that store global design info (net 
list, celllist and module list). Finally some structures that were used to manage the user ac
tions are treated. 

3.2 The floorplan datatypes 

3.2.1 Introduetion 

In this section the datatypes that were used to implement the floorplan (slicing tree, nodes, 
geometrie information, lists, etc.). First the basic datastructure for the floerplan (the SLICING 
structure) is discussed. Th en the partsof the slicing tree are discussed in more detail. All these 
structures are defined in s 1 icing . h. 

Since some of the code was based on the floerplan assembler code by R. H. Sondagh [2], his 
datastructures were adopted and adapted for the IFO programme. Notall his datastructures 
are needed directly by the IFO programme but they need to he included to make the code 
work. 

All the datatypes that are presented here are more or less objects in the sense of Object Ori
ented Prograrnrning. This means that every datastructure has a range of functions (methods) 
that opera te on them. Even the eenstructor and destructor are emulated. This has the advan
tage of having more control over default initialisation, allocation and deallocation. For the 
sake of efficient memory management each data type is not destroyed by just freeing its oc
cupied memory. Instead a list of disposed of structures of the sametype is maintained. When 
a new "object" needs to he constructed the list of previously disposed of structures is exam-
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ined. If the list is empty a new structure is allocated, else a structure is removed from the list. 
In both cases the fieldsof the structure are initialised with the samedefault values. Typically 
the name of the constructor has prefix new and the destructor has prefix delete. 

The object structures are hierarchical dependent on each other. Figure 3.1 displays this hier
archy. The objects from this hierarchy will be discussed in the following subsections from the 
top object (SLICING) to the bottorn objects. 

ListOfSiicing --+ SLICINGNode ---+ SLICING 

i\ 
tNode 

/11~ 
Locai_Net 

Net 

/~ 
POINTreal boxTypeint 

Figure 3.1: Hierarchy of objectsof the IFO application. 

The most important structure SLICING stores general information about the floorplan while 
the slicing tree itself is stored in tNodes and BranchList structures. The Cell, Net and 
Terminal structures are important for drawing the nets as outlined in section 2.5.3. 

3.2.2 The SLICING structure 

In C the slicing structure is defined as follows: 

typedef struct SLICING_ 
{ 

/* logical aspects of a slicing */ 
char *basename; /* Name of the disk file without extension */ 
char *name; /* name of the design */ 
tNode *slicing_root; /* The root of the slicing tree */ 
tNode *selected; /* The node that is selected. Or NULL. */ 
bool show_all_nets; /* If True all nets are shown if draw. Else only nets 

that are connected to selected modules are shown. */ 
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bool size_uptodate; /* Do we need to recalculate the floorplan sizes? */ 
int filled_space; /* How many space is used? */ 
bool has_netlist; /* True if a netlist file is loaded */ 

!* graphical aspects */ 
net_drawing_style net_style; /* How to draw nets */ 
float scale; /* zoom scale: 0 < scale < 1: zoom out 

> 1 zoom in */ 
boxTypeint window; /* visible part of slicing 

expressed in slicing coordinates!!! */ 

/* make it maintainable in a list for re-use */ 
struct SLICING_ *next; 
SLICING; 

27 

The first two members are used to store the name of the disk file and the design. The next 
member, * s 1 icing _root, is the root of the slicing tree. This tree is build up of nodes of type 
tNode that will be discussed in the next subsection. The *select ed member points to the 
node in the slicing tree that is currently selectedor to NULL if nothing is selected. The next 
three boolean members control some routines that draworupdate the slicing tree. 

The integer value f i lled_space is interesting. lts value represents the amount of space that 
is filled with channels or cells (functional area). That is: lt is the surn of the areasof the chan
nels and the areas of the cells. This value is calculated as a spin off result of the floerplan re
placement function. lt can be used to calculate the relative amount of functional area on the 
chip since the total area can be derived from the size of the root of the slicing tree. 

The member net_style identifies the style in which the nets are drawn. The possible values 
are defined in ifotypes. h: 

typedef enum 
{ 

star = 0, geometrie, boundingbox, net_drawing_styles 
net_drawing_style; 

The fust three values correspond with the 3 types of net drawing that are supported (star, ge
ometrie and boundingbox). The last value is used as a nurnber-of-net-styles value. U pon ini
tialisation of the SLICING objectnet_style is initialised to defaulLnet_drawing_style 
that is #defined in ifotypes. h as geometrie. 

The scale member defines the drawing scale. lts value is deterrnined by some routines that 
calculate how much of the slicing can be made visible in the given viewport This value is 
used for drawing floerplan items on the canvas and for converting canvas (screen) coordi
nates back into floerplan coordinates. See sectien 4.4.6 for more on drawing objectsin the 
X WINDOW environment. 

The window member defines the visible part of the floorplan. That is the crigin and the width 
and height of the visible part. These values are used to calculate the drawing scale and for 
testing if anitem is visible or not. The type of window is boxTypeint and is defined as: 

typedef struct 
{ 
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int origx, origy, width, height; 
boxTYpeint; 

Finally the *next member is used for makinga list of SLICING structures. For example the 
newSLICING and deleteSLICING functions use this for the list of used slicing structs. 

3.2.3 The tNode structure 

The SLICING structure refers to the root of the slicing tree by means of a pointer of type 
tNode. The other nodes in the slicing tree arealso of this type. The C definition of the tNode 

type is as follows: 

typedef struct tNode_ 
{ 

node_ type 
int 
char 
bool 

type 
level 
*name 
show_nets 

I* Channel, Module, Row, Column or Stub *I 
I* How deep are we in the slicing tree? *I 
I* The name of the node *I 
!* True if all nets of this module must 

be shown */ 
struct SLICING_ *slicing; I* Take me to your owner ... *I 
orientation_type orientation; 
POINT size I* Size ! ! *I 
POINT place I* Absolute place */ 

struct BranchList_ *parent_branch; I* Pointer to the parent branch-node *I 

I* row or column *I 
struct BranchList_ *branches I* If it is a row or a column: 

List of modules and channels */ 

I* module-node: *I 
struct cell *cell ; I* What type of cell is it *I 
POINTreal center; I* Center of the module in slicing coordinates *I 

I* channel-node: *I 
Local_Net *locnetlist; 
Local_Net *nets[2]; I* horizontal channel: 

- nets [ 0] : list of nets exiting west 
- nets [1] : list of nets exiting east 
vertical channel: 
- nets[O] list of nets exiting south 
- nets [1] : list of nets exiting north 
*I 

I* make it maintainable in a list for re-use *I 
struct tNode_ *next; 

tNode; 

The fust few members of this structure describe the general information of each node. First 
there is the type member that denotes the type of the node: A module (cell), channel, row, 
column or stub. Therefore the following type is introduced: 

typedef enum 
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Column = 0, Row, Module, Channel, Stub, Gap, power 1, clock = 2 
slicing_tree_const; 

typedef slicing_tree_const node_type; 
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The last three values are nat used by the IFO application but are inherited from the constants 
from [2]. The 1 eve 1 memher is used for keeping track of the level in the tree of this node. The 
IFO programme does nat really use this information but it was already there in Sondagh' s [2] 
structure. The *name memher is filled in by the parser (read from input file or automatically 
generated) and is displayed by the floorplan drawing functions. The memher show_nets is 
used for annotating the fact if for this node (or rather the cell it represents) the nets must be 
drawn. lt might sametimes be necessary to know the slicing tree a given node is part of (es
pecially if there are more slicing trees loaded). Therefore the slicing memher is used. The 
orientation of the node (ar its corresponding floorplan item) is recorded in the or i ent at i on 
member. This memher is of the enumerative type orientation_type that is defined as fol
lows: 

typedef enum 
{ 

RO = 0, R90, R180, R270, MRO, MR90, MR180, MR270 
orientation_type; 

For the meaning of these symbols see appendix A. The default valueupon initialisation is RO. 
The next two memhers are used to store the size and position of an item in integer floorplan 
units. The POINT structure is defined as follows: 

typedef struct POINT_ 
{ 

int x; 
int y; 
POINT; 

Every slicing tree node, except the root, has a parent. And every row or column node has 
one or mode children. This information is stared in a linked list of children. This is a list of 
nodesof type BranchList. Each BranchList node has a pointer to the child tNode and 
everychild node hasa pointer to its corresponding BranchList node in the list ofchildren of 
its parent (the *parenLbranch member). The *branches memher points to the fust child 
node's BranchList node. The BranchList structure will be discussed in more depth in 
one of the following subsections. 

The following two memhers are for modulenodes only. The cell memher points to the Ce 11 
structure that defines the properties of that module/ cell. The Cell type is discussed in more 
detaillater on. For drawing purposes the cellis calculated once and stared in the center 
memher which is of type POINTreal. Since the center of a cell doesn't necessarily fall on 
integer coordinates, this coordinate pair must be of type real. The POINTreal struct is the 
same as the POINT struct except that the coordinates are of type float now. 

Channels have nets running through them. The IFO application doesn't use this info itself. 
Maybe future versions do and since the 1/0 routines from the floorplan assembler are al
ready capable of handling this info it is stared anyway. Net information is stared using the 
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LocaLNet structure that is discussed further on. The * locnetlist stores the narnes ofthe 
nets that donatleave the channel. The *nets array stores the list of nets that leave at either 
side of the channel. 

Finally the *next pointer is used for linking tNodes tagether for rnaintaining a list of used 
tNodes. 

3.2.4 The BranchList structure 

The BranchList structure is used for rnadeling the child nodesof a row or column node. 
The children of a node are given in a branch list. The order of the children inthebranch list 
is important as pointed out in section 2.5. lts definition in C is given below: 

typedef struct BranchList_ 
{ 

tNode *node; /* Points to the successar node */ 
tNode *parent; /* Points to the predecessor node */ 
struct BranchList_ *next; /* Next and previous node in list {brother) */ 
struct BranchList_ *prev; 
BranchList; 

Of this structure the *next memher points to the child itself. The child can be of any slic
ing tree node type. The *parent memher type points to the row or column node the node 
pointed to by *node is a child of. That node thus must be of type row or column. The *next 
and *prev memhers point to the previous or next child node' s branch list node. If there is no 
previous or next node this pointer is NULL. 

Now that the relation between the tNode structure and the BranchList structure is dis
cussed the following figure 3.2 should be easy to understand. lt is shows how the sample 
floorplan frorn figure 2.1 can be translated in terrns of tNodes and BranchList nodes. Note 
that the tree in this figure closely follows the tree in figure 2.2. 

3.2.5 The Cell structure 

lnforrnation about modules is stared in structures of the type Cell. The C definition of this 
structure is given below: 

typedef struct cell 
{ 

char *name; /* name of this cell */ 
struct cell *next; /* next cell in CELL-list */ 
tNode *node; /* corresponding node in slicing-tree */ 
struct terminal *terminals;/* list of terminals on cell */ 
int nterminals; /* number of nets on this cell */ 
Celltype *type; /* module-type of cell */ 
Cell; 

The *name memher is quite obvious: It is a pointer to the C type ASCIIZ string that holds 
the name of the cell. The *next memher can be used for rnaking a list of disposedof Cell 
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Root __ _.., 

Cell C 

Branchlist 1+----l 

CeiiA Channel2 Cell B 

Figure 3.2: The sample floorplan from figure 2.1 as tree of tNodes and BranchList nodes. 

structures or for making the global celllist. The *node memher points back to the slicing tree 
node that this structure gives the cell information of. The *terminals memher points to the 
list of terminals on this cell. The Terminal structure will be discussed in the next subsection. 
In the nterminals memher is stared how many terminals there are. The *type memher 
pointstoa structure of type Celltype. Since this structure is nat directly used by the IFO 
application but "inherited" from R. Sondagh's floorplan assembler [2], this structure will nat 
be discussed further. 

3.2.6 The Terminal structure 

The Cell structure uses the Terminal structure for maintaining a list of terminals. This 
structure is defined in C as below: 

typedef struct terminal 
( 

eh ar 
Net 
Cell 
struct terminal 

Port 
int 

*name; /* name of functional conneetion */ 
*net; /* net where terminal belongs to */ 
*cell; !* cell where pin is on * 1 
*nextnet, /* next terminal (net) on cell. Used for main

taining a list of discarded telTiinals too */ 
*nextcell; /* next terminal (cell) on net */ 
*ports; 

type; 
/* list of ports corresponding to terminal*/ 
!* power or clock */ 
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bool 

Terminal; 

ne; 
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I* de termines i f terminal has a port on north 
or east side *I 

As expected the *name memher points to a string that holds the name of this terminal. The 
*net memher points to a structure descrihing the net this terminal is connected to. The Net 
structure will be discussed next. Memher * c e 11 points back to the cell this terminal belongs 
to. Pointers nextnet and *nextcell point respectively to the next net on the samecellas 
this terminal is from and to the next cell on the samenet as this terminal is on. The remaining 
memhers are not directly relevant for the IFO prograrnrne. 

3.2.7 The Net structure 

As opposed to some of the previous structures the Net structure is of more direct relevanee 
for the IFO application. There are even some memhers added to the original structure of [2]: 

typedef struct net 
{ 

char 
struct net 
struct terminal 
int 

*name; 
*next; 
*terminals; 
count[2]; 

I* net-name *I 
I* next net in NET-list *I 
I* list of terminals on net *I 

I* number of cells on net */ 
bool extern term; I* de termines i f extern terminals on net *I 
Local_Net *loc al; I* pointer to loc al net in a channel *I 
struct port *port; I* net is on port to external world *I 
int draw_id; I* Determines drawing of this net in this round *I 
POINTreal center; /* The geometrie center of this net *I 
boxTypeint boundingbox; I* The box spanning all modules connected to 

this net *I 
Net; 

The name of the net is stored in the *name member. The *next pointer is used for maintain
ing a global net listorfora list of disposedof Net structures. Also all terminals on this net are 
found in the terminal list. The fust terminal is found by following the *terminals pointer. 
Another interesting memher is draw_id. It is used tomark is this net has been drawn already 
since the last (re)draw of the floorplan. If the value of this memher differ from the version of 
the (re)draw it must be draw. In order to draw nets quickly in every drawing style the center 
and bounding box are calculated before hand for all nets of the design. The results of these 
rather cheap calculations are storedincenter and bonndingbox (the types POINTreal 
and boxTypeint have been discussed earlier). The other memhers of this structure are not 
of direct irnportance and will not be discussed. 

3.2.8 The LocaLNet structure 

Finally the Local..Net structure is treated here. This structure is used for storing information 
a bout the nets in a channel. The C definition looks like: 

typedef struct local_net 
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char *name; 
struct local_net *next; 
struct port *ports; 
int nports; 
int type; 
struct net *global; 
Local_Net; 
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The meaning of the members of the LocaLNet structure are quite straight forward. The 
name of the net is stared in *name. The pointer *next either points to the next local net in the 
channel or to the next disposed of LocaL.Net structure. The local net info is not really used 
by the IFO application so discussion of this structure stops here. The localnets information 
is ho wever stared for future use. 

3.3 The cell table, net table and module table 

These tables are hash tables that store global design information a bout respectively cells, nets 
and modules. These tables are implemented as hash tables. These tables need only to be filled 
once: When a new design is loaded. If a new version of the samedesign is loaded these tables 
don't need to change since the cells, nets and modules themselves don't change. Only the 
position and orientation of the cells may be changed. 

There is a close relationship between these lists and the slicing tree as could beseen in fig
ure 2.3. This relationship is (re)established each time a switch is made to another version of 
the design. This must be done since the lists contain pointers to nodes in the slicing tree. If 
the lists were not updated to point to the current slicing tree nodes it is very well possible 
that the pointers from the lists point to nodes of already discarded slicing trees! Fortunately 
this procedure (connecLlists_and_slicing) is not very complex in termsof computa
tion effort. Another feature of this function is that it marks all the nodesin the tree that have 
their nets drawn. This information is derived from the selected nets history (to be discussed 
later on). So to put it short, the connect_lists_and_slicing function ensures consistency 
between the various versions of the same design. 

Since these tables are only used "as is" and no extension is made to them this concludes the 
discussion of them. For more info see [2]. 

3.4 Auxiliary datatypes 

3.4.1 Introduetion 

Besides the datastructures that were described in the previous section the IFO application 
uses some datastructures of its own to control the flow of the pro gramme. These structures 
are used for keeping a number of floorplan designs in memory in order to switch back and 
forth between them. Since all floorplans have the same cells, the list of cells of which to draw 
the nets is the same for all floorplans loaded. This globallist is stared in the selected nets 
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history. One of the most powerful features of the IFO application is the ability to undo or 
redo transformations. Therefore a history of applied transformations is kept. Another list that 
is maintained is the list of selections. This list makes it possible to shrink a previously grown 
selection. 

3.4.2 The list of slicings 

The list of slicings is maintained by using the following datastructure: 

typedef struct 
{ 

SLICINGNode *first, *last; /* first and last slicing in the list */ 
int length; /* length of the list */ 
ListOfSlicing; 

Upon initialisation of the IFO application a list of slicings is allocated (with newListOf
Sl ie ing) with only one slicing. If the floorplan is updated, a new slicing is allocated and 
added to the list by the addSLICING function. This is only the list manager. The slicings it
self are reachable from the SLICINGNodes: 

typedef struct SLICINGNode_ 
{ 

struct SLICINGNode_ *prev, *next; /* pointers for previous 
and next elements */ 

SLICING *slicing; /* the slicing itself */ 
SLICINGNode; 

This structure contains pointers to the previous and next slicing list node ( *prev and *next) 
and a pointer to the actual slicing (*slicing). 

3.4.3 The selected nets history 

Every time a cellis selected for ha ving its nets drawn, the conesponding node is added to the 
selected nets history. This history is global to allloaded floorplans. The reason this list was 
introduced was the following: If in a given floorplan design a certain cell was selected and 
the floorplan was updated, the cell will be selected in the new floorplan design as well. This 
could not be achieved in another way since storing this information in the slicing tree nodes 
will not help: As the updated design is loaded new nodes are allocated that don't know a bout 
the previous slicing tree. 

The list structure is as follows: 

typedef struct selected_nets_node_ 
{ 

Cell *show_cell; 
struct selected_nets_node_ *next; 
selected_nets_node; 
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The *show_cell merober points to thecell in thecelllist of which the nets shouJd bedrawn. 
The *next merober points (as is to be expected) to the next node in the selected nets history. 

The fust node of the list is hard-coded: 

static selected_nets_node show_nets_selected = ( NULL, NULL }; 

The function update_showJlet st is used to add or removenodes from the list. Since 
the cell list does not change between the various versions of the design every cell can be 
checked if its nets must be drawn. This can be done by checking if it is in the selected nets 
history. For this the function show_cellJlets exists. 

3.4.4 The undo/redo list 

As said one of the most powerful features of the IFO applications is the ability to undo trans
formations or to redo undone transformations. For this it is necessary to maintain a list of 
transformations that have been applied so far (and where they have been applied). Further
more the undone transformations must be memorised too. For this the undo/redo list is cre
ated. This list stores all relevant user actions and related information so that it is possible to 
go backtoa certain point in the editing process. The undo/redo list is implemenled in C as 
follows: 

typedef struct undo_redo_node_ 
{ 

struct undo_redo_node_ *undo, *redo; !* Kind of prev/next pointers! */ 
struct t~ode_ *placel, *place2; /* Places in sl tree at which the last 

int action; /* Last action */ 
int action_id; /* For debugging */ 
SLICING *slicing; 
undo_redo_node; 

action occurred */ 

The first two merobers ( *undo and * redo) can be compared to the previous and next point
ers in a doubly Iinked list; they point respectively to the last applied action and the action to 
be redone after the current action. So if an action is undone, the action in the structure pointed 
to by *undo is carried out in reverse and becomes the current action. If an action is redone, 
the current action is carried out and the action in the structure pointed to by *redo becomes 
the current action. 

The merobers *placel, *place2 and * ing are used to store place in the slicing tree 
where the action was performed. This information is vital for being able to re-apply or undo 
the sameaction later. Merober action stores an identifier for the action itself. Actionscan 
be identified by integral values that are #def ined in the header file def i nes. h1. The next 
table 3.1 showshow these four merobers must be filled in for every action that is stored. 

1This header filecontains all kinds of #defines for the IFO application. 
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Table 3.1 Field values in the undo/redo listnodes fora given user action 
Field 

Action slicing placel place2 action 
None Current NULL NULL NO.ACTION 
Move item Current Stub Selected MOVEJTEM 
RotateCW Current Selected NULL ROTATE_CW 
RotateCCW Current Selected NULL ROTATE_CCW 
Mirror Hor Current Selected NULL MIRROR_H 
Mirror Vert Current Selected NULL MIRROR_V 
Update Floorplan Current New slicing NULL UPDATE_FLOORPLAN 

The "Current" value in the above table rneans the pointer to currently active slicing (the glob
al variabie act i ve_slicing). The "Selected" node pointer is the node that was selected to 
perfarm the transformation on. The "Stub" node is the stub node that is created by the Move 
Item transforrnation. The "New slicing'' memher is a bit tricky. Here a pointertoa slicing is 
casted into a pointer to a slicing tree node. Since the programme knows (by inspecting the 
action field) what to expect it knows this fact and converts it backtoa pointertoa slicing 
when needed. 

In order to fill the list with the correct val u es aft er every transformation a registration function 
is added: register_transformation. This function is called after every transformation 
with argurnents as in table 3.1. Instead of a pointer to the currently active slicing the NULL 
value can be passed. This will be autornatically translated. 

Calling the sarne function after every transformation has a handy side effect: This function is 
called in the sarne sequence as the transforrnations are applied and every tirn~ this is done. 
This makes it very easy to rnaintain the log file of applied transforrnations! 

3.4.5 The grow/shrink list 

Another feature of the IFO application is to grow or shrink the group of selected items. This 
is done by rnaking a list of the selected items until now: Each time the selection is grown the 
currently selected item is added to the grow I shrink list. Every time a new item is selected it 
becornes the base of the selected items list. Shrinking is done by rnaking the previous item in 
the list the selected item. The selection history is stared in the following doubly linked list: 

typedef struct selection_history_node_ 
{ 

tNode *node; 
struct selection_history_node_ *prev, *next; 
selection_history_node; 

Here the *node rnernber points to the node in the slicing tree of the floorplan item that is 
selected. The *prev and *next fields are for rnanaging the list. If *prev is equal to NULL this 
history node is the base node: It contains the first selected item. It is not possible to shrink the 
selection beyond this point. If the *next pointer equals NULL this node is the largest selection 
until now. The selection can be grown until the complete floorplan is selected. Growing the 
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floorplan adds a node to the list while shrinking the selection rernoves a node frorn the list. 
The rernoved nodescan be reused later since a list of disposed of nodesis kept. 
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Chapter 4 

Developing X WINDOW Applications 

4.1 Introduetion 

This chapter was added for offering a starting point for people that wish to write X WINDOW 
applications of their own. Although there are a lot of hooks a bout this subject none of them 
seems to really fulfill the needs of a novice X WINDOW programroer that wishes to write an 
application without a hassle. 

In this chapter some hooks a bout the subject of X WINDOW prograrnrning will be discussed 
fust. Than the structure of X WINDOW programmes is discussed and a code skeleton is given 
for making your own application. Finally some tips and hints derived from my experiences 
while developing IFO are given. 

4.2 Some books about X WINDOW programming 

Books that were used in developing IFO are: 

• [4]. "The Definitive Guides to the X WINDOW System" are a series of 5 reference guides 
to allaspects of the X WINDOW prograrnrning library.It contains code examples as well. 

• [5]. "Mastering Motif Widgets" is a small hooklet with useful code snippets on how to 
do things as making all kinds of dialogs. 

• [6] and [7]. "OSF/Motif Programmer's Guide" contains some information about the 
general flow of X WINDOW programmes and how to realise some of the parts. 

None of the above hookscan be entitled asthebest although [5] is one of the most useful: If 
you want a certain dialog you can browse through it until you find the desired dialog and 
read how to make it with illustrative code snippets. For details about certain functions that 
are used in this code [4] can be used. Also if you want to knowhow to do a special function 
it can be looked up in the extensive index of this series. As an alternative, [6] and [7] can be 
used. These are not as exhaustive as [4]. 

As a last but very useful souree of information the man pages can be used. 
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4.3 The structure of X WINDOW and Motif programmes 

In this sectien the structure of X WINDOW programmes is described. First the theory "from 
the books" is discussed, then a practical implementation is given. 

4.3.1 X WINDOW's structure in theory 

If you open an arbitrary book a bout X WINDOW you will find an introduetion that is similar 
to the following (see figure 4.1). 

X Window Application 

1 
Motif Widgets 

Xt lntrinsics I X Tooikit 

X Window System I Xlib 

Hardware Platform+ Operating System 

Figure 4.1: X WINDOW System Hierarchy 

First there is a hardware platform with a suitable eperating system. On top of this runs the 
X WINDOW system. This system provides the basic support for windowing and application 
development. lt is also called Xlib. On top of the X Window System run the Xt Intrinsics or 
X Toolkit. This is a set of higher level set of routines that facilitate programming X WINDOW 
applications. The Motif widgets that run on top of the X Tooikit are a set of even higher rou
tines that provide easy access to for example dialog boxes. The X Window application can 
use routines from all these levels. Also, a higher levellibrary doesn't cover alllower level 
functions. 

The Motif library consistsof widgets and gadgets and routines that act u pon them. According 
to Webster's, widgets and gadgets are: 

widget wid. get \' wij-*t\ n [alter. of gadget] 1: gadget 2: an unnamed artiele considered for 
purposes of hypothetical exarnple 

gadget gad. get \' gaj-*t\ \. gaj-*-'ti(*)r \ \' gaj-*-tre-\ \-*t-e-\ n [origin unknown] :device, 
contrivance - gad.ge.teer n 

So widgets and gadgets are "things" that implement a given behaviour. Motif distinguishes 
further between widgets and gadgets by letting widgets have their own window while gad-
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gets use the window of their owner. Widgets and gadgets have a hierarchical class stroc
ture and each widget or gadget has its own resources and may inherit resources from higher 
classes. Resources are attributes of the classes that can be used to control the functionality. 

Examples of widgets are: 

• Dialog boxes (pop up art) 

• Menus 

• Buttons 

These are all visible widgets that are used for interacting with the user. Th ere are ho wever in
visible widgets too: These widgets are supporting superclasses that provide commonly used 
resources as size, place and colour. The widget definitions can be hard-coded or be specified 
in a resource file that is read in at programme initialisation. 

Besides widgets X WINDOW also provides shells: A special type of widgets that is used for 
holding other widgets. These shells are created when the programme is initialised. 

Another aspect of an X WINDOW application is the use of callback functions. This are spe
cial functions that are called when for example a widget is realised (created), managed (dis
played) or a button is pressed. Notall of these callbacks are necessarily used but it is almost 
obligatory to have a callback function fora pushbutton since the course of the programme is 
influenced by it. 

A special kind of callback is an event. Events are generated by X WINDOW System to in
form an application about an external"event". This can for example be an exposure event 
(a window that was (partly) obscured becomes (partly) visible again) or mouse motion or 
button press events. Alleventscan be identified by the application and appropriate actions 
should be taken. 

In order to let the application and X WINDOW know which function to call when sarnething 
happens, callbacks and events are "registered". 

The last X WINDOW aspect that I would like tomention is a graphic context. These are defini
tions of how things should be drawn. In its most simple forma graphics context can beseen 
as a brush and the colour of the brush. 

4.3.2 X WINDOW's structure in practice 

As we saw in the previous section there are a lot of things to be considered when writing 
X WINDOW programmes. Therefore we will give a skeleton of how things could be done. For 
specific info about each function the manual pages should be consulted. 

First the X Tooikit should be initialised. Furthermore an application shell widget should be 
created. Fortunately there exists a function for that: XtAppinitialize. Among the argu
mentsof this function are the command line options that were specified at application startup 
and the fall-back resource values. After the X Tooikit is initialised, the Motif Resource Man
ager must be initialised with Mrminitialize. 
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At this point the resources and eaUbacks but be registered and retrieved. This needs only to 
be done if the resources were speellied in a .uil or .uid file (which I object to doing. See sec
tion 4.4). This also realises all widgets that were declared. 

Now the top most widgets should be realised and managed. This paps up the application 
window. If graphic contexts are to be used they should be created now (with XCreateGC 
and XtGetGC). 

Now everything is setup the mouse and keyboard handlers can be installed. 

Finally the programme enterstheevent loop with XtAppMainLoop and waits foruser events 
to come along. The response of the programme to these events control the flow of the pro
gramme. See [7] chapter 4 fora more detailed description of setting up a Motif programme. 

4.4 Tips and Hints on writing X WINDOW Applications 

In this section I will give some tips and share my experiences with programming X WINDOW 
programmes using Motif. 

4.4.1 The use of resource files 

It may look easy to specify or design the various dialogsof the application by using .uil files 
and compiling them to runtime loadable .uid files. However designing and specifying in C 
has some advantages I found: 

• You don't have to learn the UIL language. Although this language is not that difficult. 

• Not everything can be programmed with UIL. lt is possible (and necessary) to specify 
the callbacks that should be used and what values to pass. Ho wever the callback func
tions must be programmed in C so you end up doing one half of the job in UIL and the 
other in C. 

• You must define the same ID' s at two places: In the resource file and in some C header 
file. Furthermore you must register, fetch and create/manage the resources at runtime 
anyway. 

• When programming the widgets directly in C you have more control over the initiali
sation and default behaviour of the dialog. 

With either methad you must register callback functions so this makes no difference for the 
methad to choose. I have found the amount of code to type about the same so this isn't an 
argument either. 

4.4.2 Control exposure events 

Every time that the application window becomes (partly) visible again an exposure event 
is generated. The programme should react to this by redrawing its elient area.lf redrawing 
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this area is a relative complex task (as it is with the IFO application) unnecessary redrawals 
should be avoided as much as possible. Also programme intended redrawals should not be 
succeeded by other redrawals. Also scrolling the elient window can genera te redrawals. 

A wa y of a voiding unnecessary redra wals is to check before each screen red ra wal if there is an 
exposure event queued in X WINDOW's event queue. lf so, then skip this redrawal since the 
screen is going to be upda ted a ga in soon. Also if the screen is redraw by programme intention 
justafter an exposure event is processed the screen is redrawn unnecessary. The way to solve 
this is by initiating each intended redrawal by sending an exposure event. The exposure event 
eaUback now only has to check if there is an exposure event queued. If not then this event 
is honoured and the screen is redrawn. If there is one or more exposure event queued then 
it is removed from the queue and another exposure event is send. This event enters at the 
end of the queue. This strategy removes exposure event from the queue because the current 
exposure eventand the fust queued one are replaced by only one new one. Eventually there 
is only one exposure event leftand this leads to the redrawal of the screen. 

4.4.3 How to make dialogs to guide the application 

Sometimes you want to let the user make a decision that influences the flow of the application. 
An example of such a decision is whether to save a file before exiting the application, or not. 
The way to do this by makinga question dialog widget that has two buttons: One for sa ving 
first, the other forskipping the save operation. By making this dialog ful1 application modal 
the user must answer this question before the application accepts other input. 

Here rises a problem! By pushing one of the buttons the corresponding callback function will 
be called. Once the callback is finished the application resumes processing the event loop 
without continuing where the programmerwants the programme to continue!. This can be solved 
by setting a global variabie to the function that must be called when the programme should 
resume. 

The general flow thus becomes: 

1. Set the global variabie to the "continue function". 

2. Manage the dialog. The application waits fora button pushand calls the corresponding 
callback. 

3. If the "Save" button was pushed, do a save. Then call the continue function that was 
previously saved. If the "Continue" button was pushed, call the continue function. 

4. Once the continue function returns, it comes back to the callback function that can re
turn to theevent loop handler now. 

This strategy means that some functions need to be split in two parts: The part that issues 
the dialog and the part that continnes after the dialog is answered (the "continue function"). 
This means that this strategy won't workat "split points" in the programme where the chosen 
branch never returns to its calling point... 
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4.4.4 Making choices 

Sametimes a dialog is needed for letting the user make a selection. There are special dialog 
widgets for this. As an example the dialog that Iets the user choose the net drawing style in the 
IFO application is discussed. This dialog consistsof a window with a title, a label (prompt), 
the 3 options, a separator and an OK/Close button. The 3 options are mutually exclusive: 
Only one of them may be selected. This type of option buttons are called radio buttons as an 
analogy toa radio where only one station from the many presetscan be listened to at the same 
time. 

The codeused to make a widget (net_style_selector) for this dialog is given in appendix 
B, section B.l. This code is fairly straight forward. First a bulletin board dialog widget is cre
ated. A bulletin board is a kind of freestyle dialog widget. This widget is the net style selec
tion dialogwidget and henceit is assigned to the global widget valuenet_style_selector. 
Now a label is added. This label forms the prompt fortheuser to make a selection. Now a ra
diobox widget and its three buttons are added. We want one of the buttons to be preselected: 
The default drawing style. Therefore we set the corresponding button in the "on" state. All 
other buttons will be set to "off" automatically since the buttons know that they are to per
farm as radio buttons. Finally the callback functions for the buttons are added. Each time a 
selection is made the nurnber of the corresponding button is passed to the callback function 
neLstyle_switches_cb. The code for this callback can be found insection B.2. Note that 
a pointer to the value is passed by using the index in an array: &neLstyle_cb_value [n]. 
Finally theseparator and the OK/Close button are added. Note that this button hasn't a cali
back registered for it. If it is pushed the dialog is automatically closed. 

There are two things about this code that haven't been discussed yet. First is that every time 
a part of the dialog has been created, it must be managed by a call to XtManageChild or 
XtManageChildren. This will realise the widgets. Second is that every object in the bul
letin board must be assigned a geometrie position. It is not possible to have Motif lay out the 
widgets at an appropriate spacing. 

4.4.5 Adding resource options 

Many partsofan application may have more than one "working modus". For example the 
nets in the IFO application can be drawn in several ways. It would be nice if the user could 
set a default drawing style at programme startup. This can be accomplished by makinga re
source and a command line option for it. 

The resource is made in two steps. First there is a structure that contains all variables that are 
set by resources: 

typedef struct 
{ 

char *netdrawingstylestr; 
net_drawing_style net_style; 
appl_resource_t, appl_resource_list_t; 

Second we must teil the application to parse the values of the resources given from the com-
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mand line and in the . X default s file. Also default va lues must be speellied in case the re
source is not specified at these places. 

XtResource resources[] 
{ 

} ; 

{ "netDrawingStyle", "NetDrawingStyle", XtRString, sizeof (XtRString) I 

XtOffset (appl_resource_list_tl netdrawingstylestr) 1 XtRSt 
"geometrie"} 

appl_resource_t resourcedata; 

XtGetApplicationResources (toplevelwidgetl &resourcedatal resources, 
XtNumber (resources), NULL, 0); 

This code speellies that the supplied value for the resource netDrawingStyle must be stored 
at offset netdrawingstylestr in a appLresource_t structure. The resource is of type 
string (char *) and the default value is "geometrie". XtGetApplicationResources 
parses the speellied resources and stores the values in variabie resourceda ta. So memher 
netdrawingstylestr of resourcedata now points to the speellied string. It is same
times more convenient to have a token that represents the value of the resource. For example 
there is a typedef net_drawing_style for the possible values of the net drawing style 
and we have already "reserved" a variabie ofthis type in the resourcedata varia bie. There
fore we parse thenetdrawingstylestr field ofthis structure by camparing itto the possi
bie string values ("star", "geometrie" or "boundingbox") and setting the net_style 
member to the corresponding value from the enumerative type neLdrawing_style. 

Likewise other resources can be made. For example the colour of modules is controlled by 
the moduleColor resource. This resource doesn't need extra parsing since X WINDOW knows 
about resources for specifying colours. 

In order to make command line option for easy specification of resources the following must 
bedone: 

• Make a structure with possible command line options: 

XrmOptionDescRec options[] 
{ 

} i 

{ "-modulecolor" I "*moduleColor" I XrmoptionSepArg I (XPointer) "yellow"} I 

( "-netdrawingstyle" I "*netDrawingStyle", XrmoptionSepArg I 
(XPointer) "geometrie•} 

• In the call call to XtAppinitialize pass this structure. 

Now the values of the resourcescan be specified in three ways: 

1. In the .Xdefaults file. 

2. On the command line by use of the X WINDOW command line option -xrm. 

3. On the command line by use of the defined command line option. 
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The options in . Xdef aul t s are parsed befare the cammand line options. This means that the 
most used defaultscan be set in . Xdefaults and that they can be overridden by specifying 
the new value as cammand line option. 

4.4.6 Managing the canvas window 

One of the nice things about applications with a graphical user interface is that output is 
presented in a graphical way and that input can be done by using a pointing device (e.g. a 
mouse). What the application thus must do is translate its internat data structures to visu
alisable ones and draw these. Also it must convert user actions (mouse motion and button 
presses) to internat actions. The applications canvas window can be used for this. It can be 
used to draw things on and it is mouse sensitive. This section showshow the slicing tree from 
the IFO application is drawn and how objectsin the slicing tree can be selected by "clicking" 
on them. 

Drawing objects 

Objectsin the slicing tree have position and size information. These dimensions are given in 
slicing coordinates with the origin in the lower left corner. The canvas window is in pixel co
ordinates with the origin intheupper left corner. The trick of drawing consistsof mapping 
slicing coordinates on pixel coordinates. This is a mapping that incorporates sealing and shift
ing the slicing coordinates. The scale is calculated as the size of the canvas divided by the size 
of the visible part of the floorplan. lf the canvas is larger than needed to draw the complete 
floorplan, the floorplan is centered. This gives a margin. If the visible part of the floorplan has 
its origin not at the origin of the floorplan (which is often the case when zoomed in) the floor
plan coordinates must be translated accordingly. Thus, given a scale s, a canvas height of h, 
x- and y-margins mx and my, the origin of the visible floorplan part ( ox, oy) and the floorplan 
coordinate to be projected (x, y), the screen (pixel) coordinate (x 8 , Ys) becomes: 

X 8 mx + (X - Ox) * S 

Ys = h-(my+(y-oy)*s) (4.1) 

Since screen coordinates are in pixels and the scale can be a real the result after sealing must 
be rounded. Rounding is done to the nearest integer value. 

The mapping from formula 4.1 is correct for single coordinates. However floorplans consist 
mainly of reetangles of which some of them are adjacent. Now what would happen if two 
reetangles that lay next toeach other and have different colours (e.g. a module and a channel) 
had to be drawn? First the corner coordinates in screen pixels would have to be calculated 
using formula 4.1. Then the reetangles can be drawn in the right graphic context using the 
XFillRectangle function ofXlib. Right? Wrong! 

Floorplan coordinates can be seen as grid coordinates where the lines run over the grid. So 
two adjacent reetangles "share" a grid line. The result is that there is a row of pixels that 
"belongs" to both reetangles and that is drawn twice. The result on the screen now depends 



4.4. TIPS AND HINTS ON WRITING X WINDOW APPLICATIONS 47 

on which rectangle is drawn fust since the last rectangle drawn determines the final colour 
of these pixels. The results are even more dramatic if the reetangles are drawn in "inverse" 
mode. Similar problems arise with reetangles that are on top of each other. The solution to 
this problem is simple. Since we know that we are drawing reetangles we can decide that the 
left and top coordinates are decremented with one pixel. This pushes the left and top side 
of the rectangle away from the grid. In this way the origin of the floerplan still matches the 
origin of the canvas if there are no margins or offsets and adjacent reetangles don't overlap. 

Figure 4.2 illustrates this problem and the solution. Two reetangles need to be drawn. One 
with origin (0, 0) (in floerplan coordinates) and top right corner (2, 2.5) and the other with 
origin (2, 0) and top right corner (4, 2.75). The dashed lines indicate the grid of the floerplan 
while the solid lines are the pixel bormdaries. The scale is 6.8 pixels per floerplan rmit. This 
means that (if the margins are 0 and the visible part of the floerplan has origin (0, O)) the pixel 
coordinates of the two reetangles become: (0, 0)- (13.6, 17) and (13.6, 0)- (27.2, 18.7). These 
coordinates must be rormded and thus become: (0, 0)- (14, 17) and (14, 0)- (27, 19). This gives 
the drawn rectangles. It can be clearly seen that the reetangles share the line of pixels with 
x-coordinate 14 (which is drawn extra thick). After adjusting the right and top side of the 
reetangles we finally get the light and dark gray rectangles. 

0 5 10 15 20 25 

Figure 4.2: Overlapping reetangles and non-overlapping reetangles 

Note that as a side effect of this projection the objects with an edge on the coordinate axes 
are one pixel too large: The left rectangle is 14 pixels wide and the right rectangle is 13 pixels 
wide while both reetangles are 2 floerplan units wide. This is however hardly visible. 
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Selecting objects 

The opposite of outputting objects to the canvas is in putting objects from it. This can be done 
by selecting an object by 11Clicking" on it. In order to make this possible a mouse handlerand 
a suitable cursor must be installed. There are some Xlib and Xt Intrinsic functions for that. 

The cursors themselves are defined with the Xlib function calls from the fragment in appendix 
B, section B.3. A cursor consists of two bitmaps: A mask bitmap and a souree bitmap. The 
mask bitmap masks all pixels that belang to the cursor. The souree bitmap masks all pix
els that have a different colour (black) than the mask bitrnap's colour (white). The mask and 
souree bitmaps must be specified as Xll bitmaps. See section B.3 for an example of such a 
bitmap. These bitrnaps can be created by drawinga cursor in an arbitrary bitmap drawing 
programme and sa ving the output as Xll bitmap (.xbm file). These filescan be directly in
cluded into the souree code. In this way bitrnaps can easily be hard coded and don't need to 
be loaded at runtirne. 

Once everything is setup, every time that the mouse moves ar one of its buttons is pressed 
or released while inside the canvas window an event is generated. This event is processed by 
the currently installed mouse handler. This mouse handler gets the coordinates of the mouse 
pointer and the type of event. 

Assume that the selection handleris installed and that the user has pressed the selection but
ton. This generates a button pressed event with the current coordinates of the mouse pointer. 
The selection handler has now todetermine which floorplan object was selected. 

This can be done quite sirnple. First the screen coordinates are translated in floorplan coordi
nates. For this the inverse formula of formula 4.1 is used: 

x (xs- mx)fs + Ox 

Y = (h- Ys my)/s + Oy (4.2) 

This will give floorplan coordinates of which the integral parts are taken. Now the slicing tree 
is traversed, startingat the root. At every row or column the child is chosen that encapsulates 
the selection point. This means that fora row we choose the child that encapsulates the x
coordinate of the selection point and fora column we choose the child that encapsulates the 
y-coordinate of the child. Eventually we get in a leaf node that is either a module or a column 
node. In this case bath the x- and y-coordinate must fall in the boundaries of the object. If this 
is nat the case we haveaso called "near hit". If the current node is a column node the nearest 
object is that child object for which the y-coordinates fit and fora row the nearest object is 
that child object for which the x-coordinates fit. 

Once the selected node ar object is determined it can be processed further. Near hitscan then 
be treated as "misses" depending on for which purpose the selected object should be used. 



Chapter 5 

IFO in practice 

5.1 Introduetion 

The previous chapters only described the features of the IFO application and the implemen
talion of them. This chapter will deal with how the application behaves in practice. First the 
interaction between IFO and X WINDOW is discusseci. Next the interfacing with the global 
router GLOBROUT is discussed. Then a sample session is presented from which some results 
are derived. 

5.2 IFO as X WINDOW application 

Since IFO is an X WINDOW application it has some features that are cornrnon for this class 
of applications. Of coursethereis the graphical user interface (which was discussed in sec
tion 2.7) but here the more general behaviour is meant: Cammand line options and configu
ration files. But first two environment variables that control IFO are discussed. 

5.2.1 Environment variables 

The IFO application is controlled by two environment variables: 

1. MODULEPATH. This variabie contains the paths that should be searched for finding a 
certain module. The paths are searched in the specified order. For example when the 
design named "mux" is loaded all paths in this environment variabie will be checked if 
they contain a subdirectory called "mux". If so the application switches to this directory 
and loads the design from it. 

2. HOME. This variabie is used for getting the user's home directory. lf one of the paths 
specified in the MODULEPATH variabie starts with a"_" it is replaced by the value of this 
varia bie. 

49 
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5.2.2 X WINDOW controls and defaults 

The appearance and behaviour of most X WINDOW programmescan be controlled by a con
figuration file (. Xdefaults). In this configuration file are the default values for certain re
sources or widgets. Every time an X WINDOW application starts this file is checked for gath
ering default values. The resource specificatien lines in the configuration file fellow the fol
lowing template ifo*<widget> : <widget value>. Here ifo means that the following 
resource belengs to the IFO application. So when the defaults file is read for another pro
gramme, this line is ignored. The <widget> field denotes the widget that is modified. Some 
widgets consistsof sub widgets that are specified by another *<widget> code. The colon 
separates the widget and the value. Finally the <widget val ue> field denotes the default 
value of the resource. In most cases this is a colour value or a string. 

The following is a list of the possible controllable resources of the IFO application and their 
values. The default values are listed in parentheses. These can also be the hard coded values 
in the programme code. 

textFont Speellies the font in which texts are drawn. (fixed) 

uidPath Path where the .uid files of the application (that contain the compiled menu defini-
tions and such) can be found. (.:/usr /local/lib) 

uidFile File name of the compiled resource file that should be used. (ifo.uid) 

channelColor Colour in which the channels are drawn. (gray45) 

moduleColor Colour in which the modules are drawn. (yellow) 

textColor Colour in which the texts (module names) are drawn. (black) 

rubberbandColor Colour that is used for drawing the zoom select boxes. Note that the boxes 
are drawn inthereverse colour than specified. Which colour this is depends on what 
other applications are currently used. (red) 

selectedColor Colour in which selected cells are drawn. If a channel (or better: The row or 
column that it is part of) is selected the covered area will be drawn intheinverse of this 
colour. Which colour this is depends on the other applications that currently use the 
display. (red) 

netsColor & netsColor2 Colours in which the nets are visualised. NetsColor is used for star 
style and the segments from the net centers to unselected cells in geometrie style. Nets
Color2 is used in beundingbox style and for the segments from the net center to the 
selected cells and the net centers themselves. (blue & green) 

netDrawingStyle Style in which the nets are drawn. Possible values are "star", "geometrie" 
and ''boundingbox". (geometrie) 

orientationlnfo Some applications can't handle the orientation field yet. This option Iets the 
user choose whether this information is written to the output files or not. (True) 

Besides these widgets, the general X WINDOW widgets such as geometry and background 
color can be controlled in the same way. 
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5.2.3 Command line options 

All resource options mentioned above can also be set on the command line. In this case the 
resources mentioned above are preceded by a hyphen. Furthermore they should be spelled 
in lower case. For example: 

ifo -modulecolor purple 

will draw the modules in the colour purple. It is also possible to use the X WINDOW cam
mand line option "-xrm''. For example to specify that the netsColor2 resource should be set 
to red instead of the default green the command line should read: 

ifo -xrm "ifo*netsColor2 : red" 

There are two extra command line options for easy setting the orientationlnfo resource: 

-writeorientationinfo The same as setting this resource to true. 

-writenoorientationinfo The same as setting this resource to false. 

Another command line option is used for supplying a design to be loaded at startup. So: 

ifo m4 

will start the IFO application and load the design m4 to work with. 

If one or more illegal options are supplied (i.e. an option that could not be recognized by the 
X WINDOW system that parses the command line fustandremoves all recognized options) it 
will be leftas an argument for the IFO programme itself. IFO assumes that the fust argument 
on thecommand line is the optional design to be loaded at startup. This means that if an error 
is made in one of the resource control options and there is no design specified, the erroneous 
option will beregardedas the design to be loaded. This can lead to unwanted results but the 
programme will be aborted with the message: 

Error: ifo: Cannot locate module 'XXX' along path 'YYY'! 

where XXX is the erroneous option and YYY is the path specified in the MODULEPATH envi
ronment variable. 

5.3 Globrout 

The GLOBROUT programme was made by L.A.J. van den Heuvel as his master project. This 
programme will not be discussed in detail (that is done in [3]) but the global features will be 
pointed out and the link is made to the IFO application. 
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5.3.1 Features of GLOBROUT 

GLOBROUT is a global router for floorplans that have a slicing structure. It reads in a file in 
the .slice format (see appendix A). The input file describes the slicing structure of a floorplan. 
That is: Only the cells and their relative positions. The GLOBROUT programme also reads size 
inforrnation frorn the appropriate files (which files depends on what it can find). GLOBROUT 
can work in two modes: Planning phase and final phase. The rnain difference is that in the 
planning phase the cells are considered flexible. That is, the port positions are not fixed yet. 
Also the best cell geornetry is deterrnined. In the final phase the cell sizes and port positions 
are assurned to be fixed. This phase only routs the nets through the channels and thus deter
rnines the width of the channels. In bath cases the output is written to the appropriate files. 
As an extra feature GLOBROUT can write out a PostScript file of the various processing stages. 

5.3.2 GLOBROUT and IFO 

In order to use the global router with the IFO application the following steps are followed: 

• IFO writes the floorplan toa .slice file. 

• GLOBROUT is started as a child processin "Final Phase" mode. 

• GLOBROUT doesits job and writes the results toa .flp file. 

• IFO regains control and reads the .flp file. 

While GLOBROUT rerouts the floorplan the IFO application is inactive. Other X WINDOW ap
plications are still active however and can still be used. This rneans that while GLOBROUT is 
updating a large floorplan the user can do sorne other workin the rnean time. 

There are however sorne problerns with the use of GLOBROUT: 

1. GLOBROUT can't handle the orientation of floorplan items. This has the consequence 
that if a cellis rotated or rnirrored, GLOBROUT still uses the cell withits default orien
tation. This cancels out the effect of the rotation and rnirror transformations. 

2. In sorne cases GLOBROUT crashes. IFO notices this and is able to recover. What exactly 
causes the crash is still not clear. It seerns that it has sarnething to do with the way .slice 
files are written. If the .slice file is just written by exactly following the slicing tree, there 
is a possibility of row or column slices ha ving only one subslice (row, column or cell) 
or an ernpty subslice (when all subslices have been rnoved and only an unused channel 
rernains). 

This problern is however greatly solved by: 

• Writing the .slice files in a different way: It is possible to knowin advance if a row 
or column slice has only one subslice (by counting the children of the right type). 
If a row or column slice has only one subslice there is no slice construct (see ap
pendix A) written for it. Instead writing resurnes the fust child of the slice. 
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• Wh en moving the last subslice out of a slice the highest parent of the subslice that 
has only one subslice (more exactly: this one) is moved. This insures that there will 
be no slice without any subslices. 

3. GLOBROUT sametimes seems to hang: Especially on large designs. If this is caused by 
the complexity of the design (and thus greater computational effort that is needed) or 
by erratic behaviour of GLOBROUT is still not clear. 

4. Not really a problem but making its use more difficult: GLOBROUT needs also .ldm or 
.inst files as input. These files must be externally generated fust if they don't already 
exist. 

5.4 Tips for editing floorplan 

This section will give some tricks tha t can be used while editinga floorplan. See also the rules 
of thumb in section 2.4. 

• You can't insert a column next toanother column (by releasingit on the channel of that 
column). Likewise for rows next to rows. It is however possible to insert a column in a 
row or vice versa. 

• Columns or rows can't be merged directly but it is possible tomerge them item by item. 

• Maybe more tips when practice or functionality grows! 

5.5 Sample session 

In this section a concrete example will be given of how the IFO tooi can be used to optimise 
a computer generated design. 

Figure 5.1 shows the output of SLICE(see [1]). This floerplan was obtained by takinga floer
plan of a 3x3 multiplier and changing the sizes of the modules in order to make it more un
regular. By re-slicing the network this floerplan was obtained. SLICE doesn't take the aspect 
ratio and channel widths into account when generating a floorplan. The size of this floerplan 
is 40x40. Figure 5.2 shows the samefloerplan but now with the real aspectratiosof the cells1• 

The size now becomes 61x39. Finally figure 5.3 shows the floerplan when the channels have 
been generated too. This floerplan will be used to demonstra te the IFO tooi since it is a com
plete floorplan. The dimensions are 79x90. 

1 This figure is generated by GLOBROUT before it calculates the channels. 
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Figure 5.1: Sample floorplan for demonstrating the IFO tool. This is the result of SLICE. 

Figure 5.2: Sample floorplan when the cells have been filled in. 
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Figure 5.3: Sample floerplan befare optimisation. Now the channels are generated too. 

It can be clearly seen that the floerplan from figure 5.3 is far from optimal: In the top left corner 
is a lot of unused space and the between the modules is a lso much space. Figure 5.4 shows the 
state of the floerplan after the fust transformation that is applied: Rotation of the column that 
contains modules z [ 4] and z [ 5]. Of course GLOBROUT was called after this transformation 
has been applied. The new dimensions are 78x80, so this already is a big improvement. Note 
that although the column is transformed into a row, the modules still have the original orien
tation. This is caused by GLOBROUT. If GLOBROUT did change the orientation of the modules 
they had better been rotated back into their original orientation since they fits quite nicely in 
this place. 

By rnaving around more modules z [ 3 ] and particularly z [ 2 ] , z [ 5] and c ( 2] [ 0] that fill 
up the empty space in the top left corner, the floorplan configuration of figure 5.5 results. Ap
parently it was beneficiary to move away z [ 5] unless it was rotated previously. The size of 
the floerplan is now 70x69. That is a reduction of 32%! 
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Figure 5.4: Sample floorplan after the first step. 

Figure 5.5: Finished sample floorplan after optimisation. 
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5.6 Results 

From the sample session from the previous section the following can be learned: 

• As long as GLOBROUT can't handle the orientation of a cell some power of the applica
tion is lost. 

• It is possible to achieve smaller floorplans. However in what extend is subject to further 
research. 

• Not directly shown by the programme but memory use if quite low: About 1 MB. 
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Chapter 6 

Conclusions and Recommendations 

6.1 Conclusions 

Given the probiem definition as stated in the first chapter and given the functionalities of the 
presented IFO tooi it can be concluded that: 

• The IFO tooi can in deed be used to manually optimise floorplans. Since there were very 
few floorplans available for evaluating the IFO tooi nogeneral statement can be made 
a bout the obtainable size reduction. 

• Since GLOBROUT currentiy doesn't use the orientation information from its input files 
the rotation and mirroring transformations can't be fully exploited. 

6.2 Recommendations 

While deveioping IFO the following ideas and shortcomings rose: 

• Designs that areread in have a sizeand shapedefinition for each cell that is notchanged 
during optimisation. It might sometimes be useful toselect another variant of a cell with 
another shape. 

• Somelimes it may be handy to have more control over the slicing tree than just putting 
objects at some place. Extra control can for example incorporate moving objects higher 
up in the tree or merging nodes (row or columns). 

• Some memhers of the Design Automation section would like to have a floorplan draw
ing tooi. It should be possible to extend the IFO tooi to perform free-style floorplan de
velopment (loading cells and placing them}. 

• The positions of the terminals and pins is not used by IFO. Instead the center of a cell 
is used as a virtual conneetion point for nets. If instead of the center the exact pin or 
terminal positions are used the designer might be able to make a better decision on 
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whether to rotate or rnirror a cellor not. This is because now it can beseen where the 
conneetion to the global nets are and if localnets don't becorne global nets now. 

• In order to get sorne useful figures a bout the results of floerplan size reduction, more 
tests should be conducted on different kinds of floorplans. 

• Interfacing with COMPASS. That rneans reading files that corne frorn the COMPASS tools 
and writing files that the COMPASS tools can read. In this way designs generated by 
COMPASS can be processed using IFO and vice versa. 
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Appendix A 

File formats 

A.l .slice and .flp 

The next manual pages describe the format of the files that are used to exchange floorplans. 
They can also be viewed by issuing the following command: 

man 5 slice 
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SLICE(Ses) SLICE(Ses) 

NAME 
*.slice, *.tip- files descrihing the tloorplan slicing structure 

DESCRIYITON 
The <modname>.slice file defines the tloorplan slicing structure. It nonnally contains boundary function 
infonnation. If tloorplan optimisation is carried out and sizes and positions are assigned for all rectangles, 
the filename extension .tip should be used. Thus tloorplan optimisation generales a .tip file out of a .slice 
file. 

SYNTAX 
<file>::= 

<slice>::= 

<type>::= 

<name>::= 

<shape> ::= 

<size> ::= 

<slice>. 

"(slice" <type> [<name>] [<shape>] [<size> [<sizenarne>]] [<place>] {<slice>}")". 

"column" I "row" I "module" I "channel". 

"(name" <identifier> ")". 

"(shape" {<x> <y>} ")". 

"(size" <X> <y> ")". 

<sizename> ::= "(sizename" <identifi.er> ")". 

<place> ::= 

<orient> ::= 

"(place" <x> <y> [<orient>] ")". 

"RO" I "R90" I "Rl80" I "R270" I "MRO" I "MR90" I "MR180" I "MR270". 

Sequences of the form: 
"#" any text <eoln> 
are considered comment and skipped during parsing. 

The different slices that appear within a <slice> are ordered: in a "column" slice bottom-up, and in a "row" 
slice left-right. (Thus in the direction of increasing coordinate values.) The "module" and "channel" type 
slices are assumed not to have subslices. 

The <name> of a "module" slice should normally correspond to the instanee name as found in the <mod
name>.ml file. A <name> of a "channel" slice should correspond to an extemal definition of the channel. 

The <shape> function should model the best (smallest) attainable sizes including possible rotation of the 
module. Hence the <shape> function included for a module might differ from the original shape function 
of the module in its .shape file which is not expected to include rotation. 

The <place> specifies the global position of this rectangle (any type), thus relative to the south-west corner 
of the total tloorplan. The <orient> field allows to specify an orientation transformation when placing the 
rectangle, nonnally only useful for modules or channels. The "Rxx" mean rotation along xx degrees 
counter clockwise, "MRxx" means fust mirroring in the x-direction (replacing [x,y] with [width-x,y]) and 
then applying the rotation. "RO" (no transfonnation) is the default when omitted. 

The optional <size> specifies the width and height of the rectangle, after applying the for placement desired 
orientation transfonnation. If several instances of identical modules (i.e. have the samemodule-name (and 
-if present- the sarne paramset-narne) attached in the .mi file) are to be generaled with identicallayout size, 
an equal <sizenarne> indicates that only one layout stamp has to be generated for these instances. If the 
<sizename> is absent, it is assumed to equal to the instanee-name (given with the <name> field) and hence 
different for all instances, the layout contents for each instanee is generared separately. 

RESTRICTIONS 

- All tokens are separated by white space (spaces, tabs, linefeeds etc). 
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SLICE(5es) SLICE(5es) 

- <x> and <y> are non-negative decimal integers. 

- An <identifier> is a string of non-white printable characters of unrestricted length, starting with a letter. 

There is no upper limit on line length. 

SEEALSO 
ftoorplan(5es), shape(5es), ml(5es) 

CONTRIBUTED BY 
Jos van Eijndhoven 
Feb 18, 1992 
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The orientation symbol 

The floorplan items and their conesponding slicing tree nodes have a variabie orientation 
that can have the following values: 

RO, R90, R180, R270 The item is rotated over respectively 0, 90, 180 or 270 degrees counter 
clockwise. 

MRO, MR90, MR180, MR270 The item is fust rnirrored in its vertical centerline. Then it is 
rotated over respectively 0, 90, 180 or 270 degrees counter clockwise. 

The default orientation is RO, not rnirrored and not rotated. If a floorplan item is manipu
lated its orientation may change. Figure Al illustrates what becomes the new orientation of 
the itemaftera transformation has been applied. The squares at the top row show the origi
nal orientation. The 4 rows beneath this show the orientation after the rnirroring or rotation 
transformations are applied. N ote that there is no row for the move transformation since this 
transformation doesn't change the orientation. The dot and the cross are markers to show 
how the transformations change the orientation. The symbol in the middle of the square is 
the "code" of the orientation. 

Original GB 8 EIEJB !MR180l 8 
Vertical 

!MR180l BB88BGEI Mirroring 

Horizontal EJ IMR170I !MR180l BGEI 8 B Mirroring 

Rotate CW EIGB 8 BEJB !MR180l 

RotateCCW B 8 EIGB !MR180l BB 
Figure Al: The new orientation of a floorplan itemaftera transformation is applied 
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A.2 .nl 

The netlist is read from .nl files. The format of these files is described in the following man 
pages that can also be viewed by issuing the following command: 

man nl 
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NL(5es) NL(5es) 

NAME 
<name>.nl- net list file: description and syntax 

DESCRIYfiON 
The <modname>.nl file describes the interconneetivity of the network, by specifying for each terminal the 
net to which it conneets. 

A terminal is identified by an instanee name and a terminal name ofthe instantiated module. 

Power routing is assumed to be solved by a speeialised method, and hence power interconneet is NOT spee
ilied in this file. 

However it might be neeessary to conneet signa! inputs to power or ground Ibis is accomplished by con
necting such ports tonets with the reserved nelnarnes 'vdd' and 'gnd' respectively. Note that in many stan
dard cell designs this is forbidden, and that such connections are to be made with 'nonna!' nets to special 
cells which generate a logic 0 or 1 on their output. 

SYNTAX 
<file>::= { <netdeel>} {<incidence>}. 

<netdecl> ::= "NET" <net-name> <eoln> { <net-attribute>}. 

<net-attribute> ::= "PARAM" <attribute-name> <attribute-value> <eoln>. 

<incidence> ::= "PIN'' <net-name> <instance-name> <terminal-name> <eoln>. 

<eoln> symbolises the line tennination, in UNIX environments the '\n' character. 

The <instance-name> can be ju st"-", indicating a conneetion toa terminal of the surrounding module. This 
is only allowed ifthe terminal is deelared in the *.io file with a TERMINAL statement (see io(5es)). Other 
<instanee-name>s are deelared in the *.mi file (see ml(5es)). 

The ''PIN" lines can appear in any order. During reading do not assume that they are grouped by net or by 
instance. 

Each instanee-name/terminal-name combination can appear maximally once in the file. 

Deelarations of nets with the NET keyword are stated as optional in the grammar above. However if not 
very hard, we reeommend to write such deelarations for all nets: they might beeome mandatory in the 
future. The primary net attribute now in use is named 'WEIGHT', to control routing algorithms. 

LEXICAL ANALYSIS 
All tokens are separated by spaces or tabs. 

- The keywords start at the first position (column) of a line. 

All narnes are strings of printable non-white characters, starting with a letter, and of unrestricted length. 

An implementation using a line buffer is reeommended to have a buffer size not smaller than 1024, line 
overflow is considered an error of the reader. 

- Lines which start with '#' or <eoln> (empty lines) are to be discared. 

ARRAYS and BUSSES 
To denote (individual elements of) arrays of nets, instances and terminals, square brackets '[]' are to be 
used in the netnames, instancenames and terrninalnames. To denote a single element one unsigned integer 
is between the brackets; for multidimensional objeets several of these '[]' combinations appear in the name. 
Such narnes can be treated as a normal string as any other name, except when the application wants to try to 
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NL(5es) NL(5es) 

intemally (re-)construct real busses. 

Besides these sirnple element-by-element listings, a new extension is introduced, allowing to write down a 
vectorized net-instance-terminal conneetion for many elementsin one line. This serves two different goals: 

Reducing the size of the .nl file, especially for those files originating from architectural synthesis. 

- Allowing to more easily maintain bus constrocts between different application programs. In general it is 
far more easy to expand these vector statements into individual elements, then the reverse process of try
ing to rebuild vector constrocts from its individual elements. 

The vector construct is defined in such a way that it can be evaluated for an individualline, without requir
ing knowledge on other lines or other files: 

An instanee-name or terminal-name can contain a repetition construct such as [0:15] (two unsigned ints, 
separated by a colon, and surrounded by square brackets). This indicates a repetition over the individual 
elements [i], with i running from the fust to (and including) the second integer, either up or down. 
lf present, a matching construct such as [23:8] (running over same number of elements, but maybe differ
ent values of the index or in the other direction), MUST be present in the net-name. 
The resulting construct has the same meaning as when in a single iteration over the number of elements, 
lines are generated with a running index number between [] in both nam es. 

- An instanee-name or terminal-name can contain a repetition construct such as [0=15] (two unsigned ints, 
separated by an equal sign, and surrounded by square brackets). This again indicates a repetition over 
the individual elements [i], with i running from the first to (and including) the second integer, either up or 
down. 
However in this case NO matching construct is present in the net-name. 
The resulting construct has the same meaning as when in a single iteration over the number of elements, 
lines are generated with a running single index number replacing the int=int construct. 

Multi-dimensional constrocts are allowed, containing any number of[:] and [=] constrocts appearing in a 
single line. However the number of[:] constrocts inthenet-name must match those in the instanee-name 
and terminal-name together, and the iteration count of each (in left-to-right order) must match the itera
tion count in the instanee-name and terminal-name in the same left-to-right order. Since the [ =] con
strocts are to be evaluated on their own, the have noorderingor size restrictions. 

examples of vector constructs: 
PIN bus[0:7] my_inst in[0:7] 
# ( conneetion of a bustoa vectorized terminal) 
PIN bus[0:7] inv[0:7] in 
# ( conneetion of a bus to a vector of instances) 
PIN elk ffl0=3] elk 
# (a single net on one terminal of a vector of instances) 
PIN gnd adder left(0=7] 
# (a single netto a vectorized terminal of one instanee) 

And more-dimensional: 
PIN bus[0:3][0:7] cell[7:4] p[0:7] 
# (A 2-d bus to a few instances, each with a vector terminal) 
PIN bus[O:l5) cell[0=7) out[O:l5] 
# (A 1-d bus to the vector terminals of a set in stances) 

Note that multi-dimensional constrocts are easily generated by an expansion of a network hierarchy, 
when maintaining instanee array constructs, thus creating array constrocts for all interior elements. 

A program 'unbus' is provided, capable of unfolding these bus constrocts into lines connecting individ
ual elements. 
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NL(5es) NL(5es) 

SEE ALSO 
floorplan(Ses), io(5es), m1(5es), unbus(les) 

CONTRIBUTED BY 
Jos van Eijndhoven, June 1992 
Updated for NET, PARAMand PIN keywords, May 1993 
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Appendix B 

Code Fragments 

B.l Making the net style selection dialog 

The following is a code fragment for creating a widget for the net style selector. This fragment 
belongs to section 4.4.4. 

Widget label, radio_box, separator, toggle [net_drawing_styles]; 
XmString title_string, label_string, button_string; 
Arg args [10]; 
int n; 
char *label text "Select the net drawing style:"; 

!* Make the box */ 
title_string = XmStringCreateLtoR ("Net drawing style", chaL-set); 
n = O; 
XtSetArg (args [n], XmNdialogTitle, title_string); n++; 
XtSetArg (args [n], XmNwidth, 200); n++; 
net_style_selector = 

XmCreateBulletinBoardDialog ( toplevel, "NetStyleSelector", args, n); 

!* Add a label */ 
n = 0; 
label_string = XmStringCreateLtoR (label_text, charset); 
XtSetArg (args[n], XmNlabelString, label_string); n++; 
label = XmCreateLabelGadget (net_style_selector, "label", args, n); 
XtManageChild (label); 

/* Make and add the radio buttons */ 
n = 0; 
XtSetArg (args [n], XmNy, 30); n++; 
radio_box = XmCreateRadioBox (net_style_selector, 

"NetStyleSelectorRadio", args, n); 
XtManageChild (radio_box); 

/* Add the Radio buttons */ 
n = 0; 
button_string = XmStringCreateLtoR ("Star", charset); 
XtSetArg (args [n], XmNlabelString, button_string); n++; 
XtSetArg (args [n], XmNy, 30); n++; 
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toggle [0] = XrnCreateToggleButtonGadget (radio_box, "toggle1", args, n); 
XtFree ((char *) button_string); 

n = 0; 
button_string = XrnStringCreateLtoR ("Geometrie", charset); 
XtSetArg (args [n], XmNlabelString, button_string); n++; 
XtSetArg (args [n], XmNy, 60); n++; 
toggle [1] = XrnCreateToggleButtonGadget (radio_box, "toggle2", args, n); 
XtFree ((char *) button_string); 

n = 0; 
button_string = XrnStringCreateLtoR ("Bounding box", charset); 
XtSetArg (args [n], XmNlabelString, button_string); n++; 
XtSetArg (args [n], XmNy, 90); n++; 
toggle [2] = XrnCreateToggleButtonGadget (radio_box, "toggle3", args, n); 
XtFree ( (char *) button_string); 

!* Enforce right behaviour on the buttons */ 
XrnToggleButtonGadgetSetState (toggle [resourcedata.net_style], 

True, False); 
for (n = 0; 

n < net_drawing_styles; 
n++) 

XtAddCallback (toggle (n], XmNvalueChangedCallback, 
(XtCallbackProc) net_style_switches_cb, 
&net_style_cb_value (n]); 

XtManageChildren (toggle, net_drawing_styles); 

/* Add separator */ 

11 = 0; 
XtSetArg (args [n], XmNy, 120); n++; 
XtSetArg (args [n], XmNwidth, 200); n++; 
separator = 

XrnCreateSeparatorGadget (net_style_selector, "separator", args, n); 
XtManageChild (separator); 

!* Add ''close'' button */ 
n = 0; 
button_string = XmStringCreateLtoR ("OK/Close", charset); 
XtSetArg (args [n], XmNlabelString, button_string); n++; 
XtSetArg (args [n], XmNy, 150); n++; 
button = XrnCreatePushButton (net_style_selector, "OK/close", args, n); 
XtManageChild (button); 

!* Free memory */ 
XtFree ((char *) title_string); 
XtFree ((char *) button_string); 
XtFree ((char *) label_string); 
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B.2 Net style selection eaUback function 

This is the code for the caDback functions for the net style selector. This fragment belongs to 
section 4.4.4. 

void 

debug (3) 

tches_cb (Widget w, int *radio_button, 
XmToggleBut tonCallbackStruct *event) 

verbase ("Radio button %d pushed! \n", *radio_button); 

if (event->set) { 
if (*radio_button >= 0 && *radio_button net_drawing_styles) 

el se 

resourcedata.net_style 
send_expose_event (); 

active_sl 

error ("Wrong net drawing style 

return; 
/* net_style_switches_cb */ 

* radio_bu t ton; 

%d! \n", *radio_button); 
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B.3 Defining a cursor 

The following is a piece of code for demonstrating how to define a cursor. lt belongs to sec
tion 4.4.6. As an example the cursor for the rota te clockwise transformation of the IFO appli
cation is chosen. Code for making the black and white colours is also included. 

#include "cursors/rotcw_s.xbm" 
#include "cursors/rotcw_m.xbm" 

cursor_source, cursor_mask; 
XColor white, black; 
Cursor rotate_cw_cursor_id; 

!* Make toreground and background colars for cursors */ 
white.red = white.green = white.blue Oxffff; 
black.red = black.green = black.blue 0; 
white.flags black.flags = DoRed 1 DoGreen 1 DoBlue; 

if (!XAllocColor ((void *) applDisplay, 
Defaul tealormap ( (void *) applDi splay, screen_num) , 
&white)) 

error ("Couldn't allocate color "white"!\n"}; 

if (!~~llocColor ((void *} 
Defaul tColormap ( (void *) ay, screen_num} , 
&black}) 

error ("Couldn't allocate color ''black''!\n"); 

!* Make bitmaps for rotate clockwise cursor */ 
cursor_scurce = 

XCreateBitmapFromData , XtWindow (canvas}, 
rotcw_s_bits, rotcw_s_width, 

if (cursor_source == None) 
error ("Couldn't create souree bitmap for rotate CW cursor!\n"); 

cursor_mask = 
XCreateBitmapFromData (applDisplay, XtWindow (canvas), 

) ; 

rotcw_m_bits, rotcw_m_width, rotcw_m_height); 

if (cursor_mask == None) 
error ("Couldn't create mask bitmap for rotate cw cursor!\n"); 

/* Make rotate CW cursor */ 
rotate_cw_cursor_id = 

XCreatePixmapCursor 

!* Free bitmaps */ 
( 

XFreePixmap ( 

cursor_source, cursor_mask, &black, &white, 12, 5); 

, cursor_source) ; 
, cursor_mask) ; 
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The bitmaps for a cursor 

As an example of how the cursor bitmapslook like the cursor for the rota te clockwise trans
formation is used. 

The mask bitmap: 

Figure B.l: The mask bitmap for the rotate clockwise cursor 

#define rotcw_m_width 16 
#define rotcw_m_height 16 
static char rotcw_m_bits[] = { 

OxOO,Ox01,0xOO,Ox03,0xOO,Ox07,0xcO,OxOf,OxfO,Ox1f,OxfB,OxOf,Ox7B,Ox07,0x3c, 
Ox03,0x1c,Ox01,0x1c,OxOO,Ox1c,Ox38,0x3c,Ox3c,Ox7B,Ox1e,OxfB,Ox1f,OxfO,OxOf, 
OxcO,Ox03}; 

The souree bitmap: 

Figure B.2: The souree bitmap for the rota te clockwise cursor 

#define rotcw_s_width 16 
#define rotcw_s_height 16 
static char rotcw_s_bits[] = { 

OxOO,OxOO,OxOO,OxOO,OxOO,Ox02,0xOO,Ox07,0xcO,OxOf,Ox70,0x07,0x30,0x02,0x18, 
OxOO,OxOB,OxOO,OxOB,OxOO,OxOB,OxOO,Ox1B,Ox1B,Ox30,0xOc,Ox70,0xOe,OxcO,Ox03, 
OxOO,OxOO}; 
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